March Networks
Command 2.17 Transportation

USER GUIDE

% MARCH
networks
A Delta Group Company




Copyright © 2008-2023. March Networks Corporation. All rights reserved.

Information in this document is subject to change without notice. MARCH NETWORKS,
March Networks Command, March Networks Searchlight, March Networks RideSafe, and
the MARCH NETWORKS logo are trademarks of March Networks Corporation. All other
trademarks are the property of their respective owners.

North AMeriCa...ocoocoviiiiiiiiieeeeeen, 1 800 563 5564
Latin AmMeriCa....ccocvviiiiiiiiiien +52 55 5259 9511
BEUrOpe. +39 0362 17935
A ST +65 6818 0963
Australia and New Zealand................. +61 1300 089 419
Middle East and Africa......cccovevveiinnnns +971 04 399 5525

www.marchnetworks.com

Notice of Rights

The software described in this document is furnished under a license agreement or
nondisclosure agreement. The software may be used or copied only in accordance with
the terms of those agreements. The contents of this manual and accompanying software
are protected by copyright. No part of this publication may be reproduced, stored in a
retrieval system, or transmitted, in any form or by any means, electronic, mechanical,
recording, or otherwise without the prior written permission of March Networks
Corporation.

Part Number
41299 Rev 1.0, August 2023



Chapter 1: Welcome to Command Transportation.........cceceermmmniininennninns 5

Command Transportation OVErVIEW .......iiieeeeeeeseeeememmemmesnnsssssssssssssssssssssssssssseessrsssesesssssssssssnsssnnssnnnnnns 6
Y8 o) ole aucTe ln Yoo e =T I 6
Password Note for RideSafe GT, MT, and RT RECOIErS ....vveeeiiiiiiiiiiieeeeeeeee s 7

Additional Documentation ... s 7

CES Communication with Mobile Recorders..........ccorriiiiinnmmmnnnssssssssrr s sssssssssssss s sesssssssns 8

[\ L= AT.Y7eT ¢ Q@007 0 04 ¥ oY Lot 14 Lo T o 8

BaSIC INDOUNG P OIS it e e e e e e e e e e e e e e e e e e e e e e eeeeeeraeaaaeeaaaaes 8
Network Diagrams: Default Transportation System POrtS.......eeoeeiiiiiiiieeias 9
Default Ports for RideSafe GT, MT, or RT Series ReCOrders ... 9
Default Ports for RideSafe XT Series RECOITOIS ..uuuuuuuuiiieeeiee e 10
Default Ports fOr NAT TraVerSaAl .o e e s s e e e e e e e e e e e e e e e e e e e e e e e e e e eereae e eaararraans 11
J NI (ol 1 = F=T o T PO PUTPPR 12

Adding the Transportation Application Component..........ccccvvvrrmrimmrs s s———————. 12

Adding the License for Transportation........ccccccceeeeersiissssssmsssssssssssssssssessss s s sssssssssssssnssssnssssssssssssnns 14

Upgrading the Transportation Application Component ... ————— 15

Installing the Command Media AFCRIVEF .....cciiviiiiiiiiiieeereeeeeeeeeee s s e s s e e s s s s s s e s e s s s e s s nnnnnnes 17

Adding the Command Media Archiver to Command..........cccovvirrmmmmmmrmrrrrrrrrssssssssssssenssssssssssssssssen. 20

Deleting an Archiver or Recorder assigned tO an ArChIVEN .......uueeuiieieieiieeeiee e, 21

Backing up and Restoring the Command Media Archiver ........ccccccccirrriinnssssnssssssssrereernesessssssssssssnne 22
Backing up the Command Media ArChIVET .......uuueeceee et 22
Restoring the Command Media ArChIVEL .......uuuueeiee et 23

Upgrading the Command Media AFCRIVEF .......cviiiiiiiiieeeseeeeeeeeee s sss s s s s s s s s e s s s s s s s ssnssnnns 24

Adding the Transportation Application Rights to the User Profile........ccccvrremreeeeeeeceeeceeecennnnnnnnnnnnn. 25
Adding the Transportation Application Rights to an Existing User Profile .........ccccooeiiiinnnn 25
Adding the Transportation Application Rights to a New User Profile ..., 26

Defining Available ReSOUrCes fOr @ USEI ...cuviiiiiiiiiimirisssssssenmmmmmmmnsnssssssssssssssssssssssssssssssssssssessssssssssssnnns 29

Settings for Transportation Configuration ..........eeerrnrrrnrinrnrrr s ssssasssnns 31

Preferences for Transportation FEAtUres......ccciiiiirrrrieeereeneemmmmmmennnnsssssssssssssssnsssssssssssssssessssssssssssnnns 33
R Lo 0 L= ORI 34

Chapter 2: Understanding the User Interface ........oocccciirmmmiiinmeesinnnnnnnns 35

L0 1Y 7= V- 36

Incident Archive Tab User Interface...... o iiiiicccccsceecccmrnrr i rsssssssssssss s s e s s s s sssss s s e s s e s eesssssssnnns 39

[ Toq Lo [=1 4 L ARST=F-T e 3 1Y 1= it = 43

GPS Map USer INtEIfAcCe .uiiiiiiirrriirrriririiirssssssssssnsssnsssnsssssssssssssssssssssssssssseeesmmeseemmmessssssssssssnnnnnnsnnnsnsnnssnns 46
FRatures Of the GPS Ma oo e e e e e e e e e et e e e e e e et e e e et et arrrarbaaes 47

Incident Video and GPS Data Media Controls ........ccccccmmiiiiiccssssssssecc e ee s sssssssss s e s e e ssssssssnnas 48

10 aT=] Lo = 48

1Yo T T Lo T 1] o Y= T PTTTRTTRT 48



Chapter 3: Using the Incident Archive ......ccccicciiimeiinessinnesssnesssnsssssnesssnes D1

Creating an Incident from the Incident Archive Tab .....cccccccccciriree s 52
Troubleshooting an INCIdeNnt EXTractioN ..o 54
Creating and Managing Recurring INCIAENtS ... ssssssss s sssssssssssss s 55
Creating RECUITING INCIAENTS ..oiiiiiiieieiee et 55
Editing or Deleting ReCUrring INCIAENTS ......vvviiiiiiiiicce e 57
VIieWIiNG MY INCIAENTS .o s s s s e s e e s s s s s s mssmassssssssssssssssssssssssssssnnssnnnennnnnnnnnns 58
Searching for an Archived INCident ...........occcciiccrrmmimirrrrr e e s snm s e s e s e e e s s s smmmmmnn e e n e e s 59
Playing an INCIAENT ........cciiiiiiiiiriirriiiir s r s ssssnnssemsssmsssssssssssssssssssssssssssssssssnsssnnsnnsssnnssnnnsnnnnnnnnnnnsnnns 61
Incident Archive Tab: Recorder or Media Archiver Removed ..., 63
USING the GPS Map ... iciiiiiiiiiiisisisssinsssnnnssnsssssssssssnnssmnsssssssssssssssssssssssssssssssssssssssssnssmsssssssssnssnnnnnnnnnnnssnns 63
Using the GPS map in an INCIAENT Tal .uuuuuueieiiiiiie e 63
Using the GPS map in a Camera Tab or View Tab ... 65
VIeWIiNG TeXt OVEIIAY .iiiieiiieeiiciiiceeeeennssssssssss s s s s s s e s s s s e s s s s s s s s s s s nnssmmssmsssssssssssssssssssssssssssssnnssnnnsnnnnnnnnnns 66
CoNfIGUIING TEXE OVEIIAY weveeiiiiii e e e e e e e e e e e e e e e aaaaes 67
EXPOrting an INCIAdeNt .......cccciiiiiiiiiiiiiiiiirnrr s ssssnsssnseeemssemssssssssssssssssssssssssssssssssensssnnssnsssnsssnnnsnnnnnnnnnnnsnnns 70
Automatic Incident Creation..........iiiiiiiiiniiir s s s sssssssssssssssssssssssssssns s s e n s e e e nnnnnnnns 76
Configuring AUtOMAtiC INCIAENTS ..o 76
Viewing AUtOmMaAtic INCIENTS .o 77
Navigating Multiple Pages and Blocks of InCidents.........cccccccmrmmrriirsssssssssssceeeennreesssssssssssssssesseseessssnes 78
Refreshing the INCIdent List .......ccccciiiiiiiiiiiiissssccrrinirrrsssssssssssssssss s s s s essssssssssssssssssseesssssssssssnsnsssneseesssssnes 78
Deleting an INCIdENt....... ..o ssr s sssssemssmmsssssssssssssssssssssssssssssssssssssnnsensssnsssnnnsnnnnnnnnnnnsnnns 78
Deleting Selected Video from an INCident........ccccoiiieiciiicceecmrrinrr s sssssssssssse e e s s s ssssssssss s e s sesssnnnes 80
Viewing Available Space on the ArCRIVEF ... sssssssss s s s sss s s s e s s s e s s s nnnnns 83
Ensuring the Archiver has ENOUGh SPACe ...cuiiiiiiicecieeeecceeeeessssssssssssssss s s s s s s s s s s s e s s s s s s s s s s s s mmssmsssnssnnns 84
EXPporting INCIAEnts 1O Case FIleS ..o 84
Deleting Old or Unneeded INCIAENES ......oiiiiiiiiie e 84
Increasing the Storage Capacity of the ArChIVEl ... 84
Changing the Default Purge Time PeriOd........coo i 84
Exporting Incident Data to @ CSV File .iimmeiceecceeeessssssssssssss s s s s s s s s s s s s s s s s s s s s s s s s msssssssssssnns 85
Chapter 4: Using the Incident Search......ccccccccciiiiimmmessniiinrees e eeeenns 86
3 Tod Lo 11 01 ARST=TTod o TS o =]  T- 1 o o 87
Y= 00T 1[I Y= a =T Ao J T 87
Setting a Home Location 0N the Map ......cnnnniniisssiissssssns s nsssssssssssssssnssssssssssssssssssssssssssssnns 87
£T==1 o 11T I e T 14 Ted T [=T o] =3P 89
Viewing the Incident Search ReSUILS .........ccccvimmmmiimmiiiniminnmnnsssssssssseses s nssssnnn 92
Creating an Incident from the Incident Search Tab ......ccccccvvcriemrrrrmnr e 95
Exporting Search Results t0 @ CSV File ..cuiiiiiieeiiiiiimieeiiniirsssssssnnissssssssss s nssssssssssnsssssssss s ssnssssssnens 97
Chapter 5: Using the Command Player with Transportation........c....... 98
GPS Controls in the Command PIayer .......c.eeeeeerisnnisnisssssssssrssrrrssssssssssssssssssssnssssssssssssssssssssssssssssnes 99
Viewing a Video File with GPS Data in Command Player......ccccuuveeeeeemeeemeeemennnnnssssssssssseesenn 100

[ o X33 -1 7 /2 102



Chapter 1

Welcome to Command Transportation

March Networks Command™ Transportation allows you to collect and store video and other data
from mobile recorders located in vehicles. The collected information is then available for the
Command Solution to process.

For more information on the Command Solution, see the user guides and documentation available
for download from the March Networks Partner Portal website.

This chapter describes how to install the Command Transportation components.
It contains the following topics:

+  “Command Transportation Overview” on page 6

+ “Additional Documentation” on page 7

¢ “CES Communication with Mobile Recorders” on page 8

*  “Network Communication” on page 8

* “Adding the Transportation Application Component” on page 12

+ “Adding the License for Transportation” on page 14

*  “Upgrading the Transportation Application Component” on page 15

*  “Installing the Command Media Archiver” on page 17

*  “Adding the Command Media Archiver to Command” on page 20

*  “Backing up and Restoring the Command Media Archiver” on page 22

*  “Upgrading the Command Media Archiver” on page 24

+ “Adding the Transportation Application Rights to the User Profile” on page 25
+ “Defining Available Resources for a User” on page 29

*  “Settings for Transportation Configuration” on page 31

* “Preferences for Transportation Features” on page 33

Command 2.17 Transportation User Guide 5



Command Transportation Overview

The Command Transportation solution combines mobile surveillance with fixed facility
management. This enterprise solution provides comprehensive transportation video management.
Real-time, secure clients provide system status, alarms, and recorded video/data archives. This
enables the ultimate flexibility and access to video and audio evidence, along with synchronized
vehicle data, including interactive GPS maps.

Command Transportation allows users to:

» Extract video, GPS, and audio information from mobile recorders, from a date and time that the
user defines. GPS maps show the vehicle route and the user can click a point on the route to see
the corresponding video and audio.

* Search the video and data from the RideSafe Series recorders in all your vehicles to look for
specific incidents. Search parameters include the time period, one or more vehicles, a user-
defined area on the map, a specific event (such as an impact alarm), and the speed of the
vehicle. View one or more search results on a map to see exactly where and when the incidents
occurred.

* Automatically download video, GPS, and audio information when certain alarms are triggered.

+ Display live GPS maps with vehicle current location, route / speed / position, and associated
video.

* Export video, GPS, and audio information to external files for evidence.

Supported Recorders
The following mobile recorders support all of the Command Transportation features:

+ RideSafe XT Series IP NVR (all models)

* RideSafe GT Series Hybrid Transit NVR (all models)
* RideSafe MT Series IP Recorder (all models)

+ RideSafe RT Series IP Recorder (all models)

The XT Series recorders are configurable using the Command Config software application. For
more information, see the RideSafe XT Series IP Recorder Configuration Guide, available from the
March Networks Partner Portal website. The Command Config application is part of the Command
software suite.

The GT, MT and RT Series recorders are configurable using the Administrator Console application.
For more information, see the Administrator Console User Manual (for Transit Recorders), available
from the March Networks Partner Portal website. The Administrator Console is part of the Visual
Intelligence (R5) software solution.

You can view and manage video from the RideSafe series recorders (all models) when Command
Client is connected to Command Enterprise (supports multiple recorder connections) or when
Command Client is connected directly to a single RideSafe recorder.

All the RideSafe Series mobile recorders can be registered to the Command Enterprise Software
(CES) using Command Client.

For the XT Series recorder, you can alternatively use Command Config to register it to the CES, see
the RideSafe XT Series IP Recorder Configuration Guide.

For the GT, MT and RT Series recorders, you can alternatively use the setces command in the
provisioning interface to register them to the CES. For more information on the setces command,
see the Provisioning Interface Technical Instructions.



Password Note for RideSafe GT, MT, and RT Recorders

All RideSafe GT, MT, and RT recorders manufactured or repaired after January 1, 2020 are shipped
with the default recorder password set to the unit serial number. The recorder’s serial number is
found on either the March part label on the side of the unit or under the QR code on the front of the
unit. The user name remains unchanged (admin).

It is strongly recommended that you change the default password by accessing the recorder’s
provisioning interface and using the setsecure command (not setpass). The setsecure command
changes the local access password for clients that require authentication, such as the Administrator
Console and Command Client. The setpass command changes the password for SSH clients (such
as PuTTY).

For more information on the provisioning interface commands, see the Provisioning Interface
Technical Instructions.

Additional Documentation

The following table describes where to find more information on the interface that you are
interested in. All the user guides are available for download from the March Networks Partner
Portal website.

Interface Purpose and Applicable Mobile Recorders User Guide

Command Enterprise You access Command Enterprise using the Command Enterprise and Client

Command Client interface. User Guide
When Command Client is connected to Command Enterprise Installation
Enterprise, you can view live and archive Guide

video, manage, and export video from
multiple RideSafe Series recorders.

When Command Client is connected to a
single RideSafe Series recorder, you can
view live and archive video, manage, and
export video from that recorder only.

Command Player View exported video, snapshots, and notes Command Player User Guide
from the RideSafe Series recorders.

Command Config Configure the RideSafe XT Series recorders. | RideSafe XT Series IP Recorder
Configuration Guide

Administrator Console | Configure the RideSafe GT, MT and RT Series | Administrator Console User Manual
recorders. for Transit Recorders




Welcome to Command Transportation

CES Communication with Mobile Recorders

Mobile recorders are constantly moving between networks as the vehicles they are installed on are
changing location. This means that a recorder acquires different IP addresses at different points in
time. The IP address used to register the recorder may not be available to reach the recorder at a

later point, so the Command Enterprise Software (CES) dynamically updates the recorder address
as it needs to communicate with the recorder.

The process is as follows:

1 A mobile recorder managed by Command Enterprise notifies CES that it has an event of
interest.

CES captures the remote IP address contained in the notification.

3 Before fetching the event, CES checks whether the remote IP address is different from the one
currently stored on the database for that recorder.

If the remote IP address is not different, CES continues to fetch the event.

If the remote IP address is different, CES attempts to communicate with the recorder at the
remote IP address.

* |f CES can communicate using the remote IP address, the IP address in the database is
updated to the new remote address and CES fetches the event using the new address.

If CES cannot communicate using the remote IP address, a health alert is raised to indicate that CES
cannot communicate with the recorder.

Network Communication

This section outlines the default ports used in a standard installation. If other ports are required,
some of the defaults ports can be changed.

For more information on network communication and default ports, see the Command Enterprise
and Client User Guide.

Basic Inbound Ports

The following diagram shows the default inbound ports required for Data Center, Bus Depot,
and bus recorder communication.

Data Center Bus Depot Recorders on Buses
3 o : ot
=~ Ports: Ports: e m orts:
Command <}— 80 ' — < 8080, Rlde_Safe < 22,
Enterprise 443 Archiver 444 Series 2880
Server (CES) "

Note: If you are only using RideSafe XT Series recorders, or your system is completely upgraded to
Command release 2.7 or higher and Visual Intelligence (R5) release 5.14 or higher, you may not require
all these inbound ports. See the following diagrams (“Default Ports for RideSafe GT, MT, or RT Series
Recorders” on page 9 and “Default Ports for RideSafe XT Series Recorders” on page 10 for more
information.

Command 2.17 Transportation User Guide 8



Welcome to Command Transportation

Network Diagrams: Default Transportation System Ports

The following diagrams show the default transportation ports for a system with RideSafe GT, MT, or
RT recorders, a system with RideSafe XT recorders, and a system using NAT Traversal.

Default Ports for RideSafe GT, MT, or RT Series Recorders

The following diagram shows the default network ports for a transportation system with a CES,
Command Client, Administrator Console, an Archiver, and RideSafe GT, MT, or RT Series recorders.

The arrows show the direction of initial connection between the network elements

Provisioning Bus Depot
Interface w

. | | ! N

22 / =S A\ ——y .
| -
‘L 444 Archiver router / W| Fi 8080
access point
Recorders 8404830’ 4 |
onBuses &1 80 |
443
[} <—— 8080 i 443
Ll By
RideSafe GT/MT/RT 444 80 Cogmanol
Series Recorder 1 ‘L lent
4 ! 80 —
443
4001 b a3z Data Center e/’
I | |
router —t— 443 - 80 —> Command
(optional) Enterprise < 443
Server (CES)
(Each bus >
has one Administrator
recorder) ¢ 80 Console

# Ports for Command 2.7 & R 5.14 or higher

#  Additional ports for Command 2.6 &
R 5.13 or lower

Note: If your system is completely upgraded to Command release 2.7 or higher and Visual
Intelligence (R5) release 5.14 or higher, you only require the blue colored ports | # . If some of your
components are at a lower release, the gray colored ports # are required until you upgrade all
components.

Command 2.17 Transportation User Guide 9



Welcome to Command Transportation

Default Ports for RideSafe XT Series Recorders

The following diagram shows the default network ports for a transportation system with a CES,
Command Client, Command Config, an Archiver, and RideSafe XT Series recorders.

The arrows show the direction of initial connection between the network elements

Bus Depot
| LN
N =S A\ —— oy \
444 . router / Wi-Fi 444
Archiver
/‘ access point
Recorders A p \Clients
on Buses
443
S [ ~7!:,‘“/
RideSafe XT Series 4.44 Comman(cji Client
Recorder an
| v 143 //Command Config
4001 Data Center / J
| £
! | |
| — ==
router 443 > Command
(optional) Enterprise
Server (CES)
(Each bus i
has one
recorder)

Note: The RideSafe XT Series recorders require Command release 2.15 or higher. RideSafe XT
Series recorders are configured using Command Config release 6.4 or higher.

Command 2.17 Transportation User Guide
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Welcome to Command Transportation

Default Ports for NAT Traversal

The following diagram shows the default network ports for a system with a CES, Command Client,
Administrator Console, an Archiver, and recorders. This example is using a STUN and/or TURN
server for NAT traversal.

Note: For more information on using STUN and/or TURN servers with Command, see the
Command Enterprise Installation Guide.

NAT traversal is supported on components are at Command release 2.7 or higher and Visual
Intelligence release 5.14 or higher.

If you are using the local STUN server provided with CES, the default port number is 3478. The
STUN port is a UDP port, not a TCP port.

If you are using an external STUN server, all UDP ports must be available.
If you are using a TURN server, the provider of that TURN server determines the port numbers.
The arrows show the direction of initial connection between the network elements.

Bus Depot
| | !

] = \ ——
/ router / Wi-Fi

Recorders Archiver

444 access point 444 Clients
on Buses 7 T I
/ | | \
:5‘\1/ 444 443
. . | / Command Client
RideSafe Series I 443 and
Recorders Data Center / /Command Config
(all models) £ UDP 3478
1‘ UDP 3478 - for local ’
4001 for local —> i E=S _~ STUN
| STUN Command 4] p—
| Enterprise
\ —— 443 > Server (CES) <« VIV -
routgr - Administrator
(optional) Console
(Each bus L AIUDP 5 STUN <— AllUDP .
has one Ports Server(s) Ports
recorder) )
—— See TURN — See TURN ——
"A Provider TURN Server(s) Provider

Note: The NAT Traversal feature uses UDP to communicate between the client and recorder. When
using only a STUN server, if your network uses outbound filtering you must permit UDP traffic (to
any port number) between the client and recorder so that NAT Traversal can connect to the
dynamically allocated ports on the NAT devices.

If this is not possible, you may need to configure a TURN server.

If you require more information, contact March Networks Technical Support.

Command 2.17 Transportation User Guide 11



Welcome to Command Transportation

Access to GPS Maps

To allow the Command Client interface to load the default GPS maps, you must ensure that any
computer where the Command Client is installed can reach the api.maptiler.com domain over
HTTPS (on standard port 443).

=« IP Camera 2 B i
System ~ MohamedDVR = MarchRSDVR  IP Camera 2 (= =T LS =l

2 :34:3( ’ 3 +34:
m( hane oy, 4. MR MarchRSDVR 24/02{20217:34:31 AM

= Hanger Dr
H ‘%.q’;"%rgomw
& or

Bucknell Rd— |

any sifiouey -

Mg & .FE-ILD“

: % :

| [ i ]
~NassauRd B

i z”"w LE§ i GPS map

%‘%

(8
Tl
2

-
‘&@ %
2
\Wake Forest Rd-
o
2
5

Wednesday, February 24
IDIM 7:30‘M

Februsry-23-21
EPM | oM | 10PM | 11PM | 12AM 1AM 2AM 3AM | 4AM S5AM | GAM  7AM  BAM  oAM | 1AM 11AM | 12PM | IPM | 2ZPH | IPM 4PM SM | BPM TPM

> ey = o Qe w3 %

Adding the Transportation Application Component

You can add the Transportation application component to Command Enterprise.

The Transportation component adds the Incident Archive tab and GPS mapping capability to the
Command Client interface. The Incident Archive tab allows you to extract video evidence from
mobile recorders. GPS maps display route information from the vehicle where the mobile recorder
is located.

You must have the Additional Component Management user right in your Command user profile to
perform this task.

Note: If your organization must be compliant with the General Data Protection Regulation, note
that data recording (for example, video, text, audio) is only initiated when an analog camera is
physically connected to a recording device or an IP channel is added using the software. Adding
the Transportation Application component does not initiate data recording. The Transportation
Application does not process media (video and audio), processing occurs on the recorders and the
Command Media Archiver.

For more information on recording policies and how the March Networks products work with the
General Data Protection Regulation, see the March Networks Solution Data Protection and Privacy
Application Note, available from the March Networks Partner Portal website.

To add the Transportation application component to Command Enterprise
1 Click the button at the upper-left of Command to display the main menu.

Command 2.17 Transportation User Guide 12



Welcome to Command Transportation

2 Select Additional Component Management.
v,

March Networks

M
. COMMAND

R License Management

'.igl' Additional Component Management

h User Management I:}

The Additional Components tab opens.

Fi? Additional Components NEEE
+ &
Name ¥ | Version ¥ Target SDK Version ¥ | Developer ¥ |Status ¥ | Installed Time ¥ | Started Time 7V

Description

3 Click the Load Application button.
A new window opens, where you can locate the Transportation zip file.

4  Select the Transportation application zip file (CommandTransportation<version>.zip) and
click Open.

The application appears in the list of the Additional Components tab.
Fiﬂ' Additional Components e TP
+ W
Name ¥ |Version T | Target SDK Version ¥| Developer 7 | Status T | Installed Time T | Started Time ¥
Transportation 2.15.0.1676 1.11.0 March Networks Installed  2022-04-06 2:06:43 PM  N/A

5 Inthe list, select the component named Transportation and click Start Application u
Fi? Additional Components X == -
+ & X »
Name T | version T | Target SDK Version T | Developer T | Status T | Installed Time T | Started Time T

6 The Status changes to “Started” and the date and time appears in the Started Time column.

-iﬂl Additional Components % 4 -
+®x » 0O

Name ¥ |Version T | Target SDK Version ¥ Developer T |Status T | Installed Time T | Started Time

Transportation 2.15.0.1676 1.11.0 March Networks Started  2022-04-06 2:06:43 PM  2022-04-06 2:10:02 PM

Notes:

* You can remove the application by selecting it in the list and clicking the Uninstall
Application m button.

* You can restart the application by selecting it in the list and clicking the Restart Application

button.

Command 2.17 Transportation User Guide 13



Welcome to Command Transportation

Adding the License for Transportation

The transportation component requires a license to run it. In Command Enterprise, the Additional
Components subtab of the Licensing tab allows you to add licenses for custom applications
added to Command.

Note: You cannot add the transportation license to Command until you have added the
transportation component, as described in “Adding the Transportation Application Component” on
page 12.

You can acquire your Command Transportation license (an .xml file) from your March Networks
representative or Customer Support.

To add the Transportation license to Command
1 Click the main menu and select License Management.

March M

v,
. COMMAND

‘ License Management %

Fﬁﬁ: Additional Component Management

The License Management tab opens.

Q, License Management
Recorders  Additional Components
Qb ot
Recorder Licenses Total: 10 Remaining: 9  Type: Permanent
Channel Licenses Total: 40 Remaining: 20 Type: Permanent

Mame T  Path ¥  Status T  Licenses Channels inUse ¥ | Max. Channels ¥ | Model
ﬁ TPCRSSVR_2  System/TPCRSSVR_2 v 20 5 12 128 Command Recording Server  10.53.103.91
ﬁ ClaireCRS System/ClaireCRS v 205 8 128 Command Recording Server 10.53.104.75

2 Click the Additional Components subtab.
The Additional Components subtab opens.
Q, License Management i IR
Recorders  Additional Components
a0
Name ¥ |Status ¥ License Type T | Feature ¥ | Resource Type ¥

Select component to view details.

3  Toimport/enable the new license, click the Add License G.,"' button.

Command 2.17 Transportation User Guide 14



Welcome to Command Transportation

Locate and select the license.xml file and click Open.

The License Added dialog box appears, indicating the license is applied to Command, and the
details of the license are added to the list.

Q, License Management A R

Recorders  Additional Components
+
Qb ot
Name ~ ¥ |Status ¥ | License Type ¥  Feature ¥ | Resource Type T

v

Transportation Permanent

Developer:

March Networks
techsupport@marchnetworks.com
http://marchnetworks.com

Licensing Rights:
Commercial license

State:
Installed , Permanent license

Description:
Allows management of video extraction from mobile DVRs.

Note: If the license failed to import, an error message appears, indicating the reason for the
failure.

Upgrading the Transportation Application Component

You can upgrade the transportation application component if a new version is available to you.

Note: You must have the Additional Component Management user right in your Command user
profile to perform this task.

Important:

After a Command Enterprise software upgrade, the Transportation application may no longer be
compatible with Command Enterprise. If this occurs, the Transportation application is
automatically stopped and an Upgrade Required notification appears in the Additional
Components tab. You must upgrade the Transportation application and manually start it again.

To upgrade the Transportation application component
1 Click the main menu and select Additional Component Management.

W tarch Networks
’v COMMAND

R License Management

i
Fil Additional Component Management

N

h User Management
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The Additional Components tab opens. The current release of the transportation application is
displayed in the list.

Fiﬂl Additional Components % o -

+%x » 0
Name ~ T | Version T | Target SDK Version T Developer ¥ Status ¥ | Installed Time ¥ | started Time
Transportation | 214.0.0170| 1.11.0 March Networks | Started 2021-08-14 10:09:59 AM | 2021-08-14 10:10:11 AM

Note: You can upgrade when the transportation application is in either Started or
Installed status.

2 Click the Upgrade Application button.

A new window opens, where you can locate the Transportation zip file for the new version of
the application.

3 Select the new version of the Transportation application zip file
(CommandTransportation<version>.zip) and click Open.

The Uploading Application dialog appears. This dialog displays the progress of the upgrade.

W Uploading Application

69%

Cancel

When the application finishes uploading, the Access Rights Change dialog appears to indicate
that there has been a change in an application.

A\ Access Rights Change

Your access rights or applications have changed.
Log on again or contact your system administrator.

oK

4 Click OK.
Command Enterprise automatically logs you out.

5 Enter your user name and password to log in and open the Additional Components tab again.
The Version column displays the new release that you just upgraded to.

'i? Additional Components x4+ -
+® %X -0

Name ¥ |Version T | Target SDK Version ¥ Developer T |Status T | Installed Time T | Started Time

Transportation 2.15.0.1676 1.11.0 March Networks  Started  2022-05-17 12:51:25 PM 2022-05-17 12:57:03 PM
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Installing the Command Media Archiver

In order to extract information from your mobile recorders, you must install a Command Media
Archiver.

Important: For Command Transportation, you must install the Command Media Archiver on a
separate server from the server where the CES is installed.

The Command Media Archiver collects and stores video and other data from recording devices. For
example, the Archiver can be used to collect incident video from mobile recorders located in
vehicles. The collected information is then available for the Command Solution to process.

For Command Media Archiver system requirements, see the Command 2.17 Release Notes
available in PDF format from the March Networks Partner Portal website.

Note: Retention limits on the Command Media Archiver are not the same as on recorders. You can
change the default retention period on the Command Media Archiver if necessary (see “Changing
the Default Purge Time Period” on page 84) and you can manually delete incidents or selected
video from the Command Media Archiver using the Incident Archive tab (see “Deleting an Incident”
on page 78 and “Deleting Selected Video from an Incident” on page 80).

To install the Command Media Archiver

1 Find the CommandMediaArchiver_<version number>.exe file in the software installation
package and double-click to open the file.

The Command Media Archiver Setup wizard appears, with the License agreement for you to
read.

2 Select the check box to agree to the license terms and conditions.
You must select this check box to continue.
3 Click Install.

The Setup Progress page appears, with a progress bar, and initiates the appearance of the
Welcome page. Note that the Welcome page appears on top of the Setup Progress page.

{# Cornmand Media Archiver Setup (== =]

March Nm—&mmznmmhm%
COMr“ ‘_’ﬁ Cormrand Media Archiver Setup EI' (=] '@

March Network: .
AN A NS Welcome to the Command Media

Media Archiver Setup Wizard

The Setup Wizard will instal Command Media Archiver on | e—
your computer. Click Mext to continue or Cancel to exit the
Setup Wizard.

ey
Eack. et ] [ Cancel ]
% MARCH'
networks
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7 Choose a drive from the Select Drive drop-down list.

Click Next.
The Destination Folder page appears.
rﬁ! Command Media Archiver Setup = e e
Destination Folder V
Click Mext to install to the default folder or dick Change to choose another.

Install Command Media Archiver to:

|C:\,Program Files\MarchNetworks\Command Media Archiver),

Welcome to Command Transportation

In the Destination Folder page, you can click Next to accept the default installation path.

(Optional) If you want to select a different installation path, click Change. A new page opens,
titled Change Destination Folder. Browse to select the new installation folder and click OK.

The Storage Settings page appears.

-
@ Command Media Archiver Setup

Storage Settings

Configure Command Media Archiver disk space settings.

data. Additional disk space outside this area may be required for images and

video data, use a value of 0 to disable the Video Archive.

Video Archive Size: | GB

Select Drive: -

used to archive video.

Back Next

The Video Archive is a pre-allocated area that stores case or incident related video

recorder log files. Refer to the user documentation for guidance on selecting a
Video Archive size. If this archiver is not intended to store case or incident related

10 GB of disk space from the selected drive is required in addition to the disk space

Cancel

In the Video Archive Size field, enter the amount of space you want to allocate for media

storage.

The amount of space you require for the Archiver Video Archive depends on various factors,
including what you are using the Archiver for (Transportation video, Case Management), the
length of time you want to retain video on the Archiver, the number of recorders and cameras in
your system, and the frequency of incidents. Daily recurring incident extraction increases the

space requirements exponentially.

If you are using the Archiver for Case Management as well as Transportation data, see the
Command Enterprise and Client User Guide for more information about storage requirements

for case management.
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Click Next.
The Network Settings page appears.
rﬁ Command Media Archiver Setup ==
Network Settings W
Configure Command Media Archiver network settings.

HTTP Port (eg. 8080): a0a0

Enter the local port to use for unsecure communications.

HTTPS Port {eg. 443): 444

Enter the local port to use for secure communications.

Enter a port number in the HTTP Port box.
The Media Archiver uses this port for non-secure communications.
Enter a port number in the HTTPS Port box.

The Media Archiver uses this port for secure communications. The default port for
transportation is port 444.

Note: The installation process opens exceptions for the HTTP and HTTPS ports in the
Windows Firewall, if it is running. If you are using a different firewall, you must configure the
port access yourself.

Click Next.

The Ready to Install page appears.

Click Install.

When the installation is complete, the Completed page appears.

-
ﬁ Command Media Archiver Setup =

March Networks

AND Completed the Command Media Archiver
Setup Wizard

Click the Finish button to exit the Setup Wizard.

% MARCH

neatworks

Back Cancel

Click Finish.
The previous Setup Progress page shows Setup Successful.
Click Close to exit the Setup wizard.
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Adding the Command Media Archiver to Command

After installing the Command Media Archiver application on the computer, you must register the
Archiver to Command Enterprise.

Note: You can register more than one Archiver to Command, but if you have multiple archivers,
you must assign recorders to an archiver by dragging and dropping mobile recorders from the
Navigation tree to the desired Archiver. (When only one Archiver is registered to Command,
recorders are automatically assigned to it.)

To add the Command Media Archiver to Command Enterprise

In the System tree, navigate to a folder element.
2 On the Navigation toolbar, click the Add Resource button and click Device.
The Add Device dialog box appears.

B Add Device

Network Address

User Name

Password

Cancel

Tip: You can also right-click a folder and click Add > Device.
In the Network Address box, enter a valid IP address or server name.

For the Command Media Archiver, you also require a port, in the format <IP address>:<port>.
The default port for the Media Archiver is 444,

In the User Name and Password box, enter the default credentials: user name admin, no password.
Note: Once the Archiver is registered, it is secured and the admin account is no longer available.
Click Add to register the device.

The device is added to the System tree and indicates a status of Registration in Progress.

When the registration is successful, a device tab with the host name of the Media Archiver
opens in the workspace. You can view information about the archiver in this tab.

If you only have one archiver, you do not need to assign recorders to it - they are automatically
associated with the only archiver present.

E Archiver 1

Name T |Path

Address 10.53.105.122:444
NAT Connection Type  N/A

Registration Address 10.52.105.122
Hostmame Archiver 1

Edit Network Settings

Model Command Media Archiver
Sarial Number 3296323814D446B7862033AC087061DA \75%
Station Identifier NVR-10209

Version 2.12.0.3233 T
Regisiration Status Registered Tee Space
o 100%

Service Status In Service 82.07 GB
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6 You can add multiple Media Archivers to Command Enterprise.

If you have multiple Media Archivers, you must assign recorders to an archiver by dragging and
dropping mobile recorders from the Navigation tree to the archiver. You can assign and re-
assign (move) recorders from one archiver to another.

Important: When there are multiple Archivers, you must ensure that every mobile recorder is
assigned to an archiver. A mobile recorder must be assigned to an archiver to enable features
such as automated incident extraction (see “Automatic Incident Creation” on page 76) and
automated log collection.

W March Metworks o 10.53.104.132
. COMMAND daire

NAVIGATION EVIDENCE ¥ E Archiver 1

x

. Name T |Path

% (W HAGPS

Move To Archiver 1

Drop NVRs here to assign them to this archiver

+— 3@ 8000 series DVR

- @ Mobile DVR
|

- HAGPS " Address 10.52.105.122:444 i \ Sett

5 Archiver 1 NAT Connection Type  N/A Sl ARSI SR
i 2

E Archiver 2 Registration Address 10.53.105.122

Hostmame Archiver 1 .
Model Command Media Archiver Eled

Serial Number 3296323814D446B7862033AC087061DA 259% /\75%
Station Identifier NVR-10209

% Logical o Version 2.12.0.3233 / .
. _' Registration Status Registered szre;; 7|:|acGe B
# Personal Service Status In Service 0% - 100%

Deleting an Archiver or Recorder assigned to an Archiver

If you delete a recorder that is assigned to an Archiver, or delete the Archiver itself (delete from
Command Enterprise so that the device no longer appears in the Navigation tree), the incidents
associated with that recorder or that Archiver are visible, but can no longer be viewed (see
“Incident Archive Tab: Recorder or Media Archiver Removed” on page 63).

* |f you delete only a Media Archiver, you can automatically restore the incidents by adding the
same Media Archiver back to Command. You can then view the restored incidents as normal.

* If you delete a recorder, you CANNOT restore the incidents by adding the recorder back. Once
a recorder is deleted, the incidents associated with it are no longer accessible.
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Backing up and Restoring the Command Media Archiver

March Networks recommends that you back up your Command Media Archiver at regular intervals.
Always back up your Command Media Archiver before you uninstall or upgrade your Command
Enterprise software.

Important: Backing up your files is a precautionary measure to safeguard your information. Backup
files are only required when you want to restore the Command Media Archiver.

Backing up the Command Media Archiver

The following procedure describes how to back up the files in your Media Archiver. March Networks
recommends that you perform this procedure at regular intervals to safeguard your information.

To back up the Command Media Archiver

1

In the Windows Control Panel, go to System and Security -> Administrative Tools -> Services.
Note: You can alternatively type “services” in the Search field of the Windows Start menu.

The Services window appears.
[ % Services @E@

File Action View Help

e Al o) REREREN 7 ol R T

. Services (Local) . Services (Local)
Command Media Archiver MName = Description Status Startup Type Log On As E
. ‘. Certificate Propagation Copies user... Started Automatic Local System [
Stopthe Senice 5 CNG Key Isolation The CNG ke...  Started Manual Local System B
Restart the service
S COM+ Event System Supports Sy..  Started Automatic Local Service
£ COM+ System Application Manages th... Manual Local System
Description: #3 Command Media Archiver Command .. Started Automatic Local System
Command Media Archiver 2.1.0.1306 “. Computer Browser Maintains a...  Started Automatic Local System
o ConfigMgr Task Sequence A..  ConfigMgr ... Manual Local System
% Configuration Manager Rem...  Provides th.. Disabled Local System -

\ Extended /(Standard /

Stop the Command Media Archiver service.
Back up the files in the following location:
<Install Drive>\Command Media Archive\

where </nstall Drive> is the drive where the Command Media Archiver was installed (see
“Installing the Command Media Archiver” on page 17).

Your backup must include the config.json and state.json files and all subfolders. The logs folder
is not required.

Ensure that you back up the files in the folder locations that are designated for transaction,
media, and/or image storage.

You can open the config.json file in a text editor to view the configured paths.

Note: For the media storage, you must add a STORAGE folder to the location in the config.json file.

+ For transactions, back up all the files in the “transaction” path in the config.json. For example:
<Storage Drive>\Command Media Archive\Transactions\Ready

* For media, back up all the files in the “archiver” path in the config.json, adding a
“STORAGE” subfolder after the path. For example:

<Storage Drive>\Command Media Archive\STORAGE
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* Forimages, back up all the files in the “images” path in the config.json. For example:
<Storage Drive>\Command Media Archive\Images

where <Storage Drive>is the location selected for the Video Archive during Archiver installation.

Restart the Command Media Archiver service.

Restoring the Command Media Archiver
The following procedure describes how to restore the Command Media Archiver on a new system.

To restore the Command Media Archiver

1

Install a new version of the Command Media Archiver. See “Installing the Command Media
Archiver” on page 17.

In the Windows Control Panel, go to System and Security -> Administrative Tools -> Services.
Note: You can alternatively type “services” in the Search field of the Windows Start menu.
The Services window appears.

- Services @M

File Action View Help

ez |[EE R H=Z > o nwn

5 Services (Local) . Services (Local)
Command Media Archiver Name : Descripticn Status Startup Type Log On As -
. % Certificate Propagation Copies user ... Started Automatic Local System a
Stopthe senice £ CNG Key Isolation The CNG ke...  Started Manual Local System N
Restart the service
5 COM+ Event System Supports Sy.. Started Automatic Local Service
L, COM+ System Application Manages th... Manual Local System
Description: . #4 Command Media Archiver Command ... Started Automatic Local System
e ., Computer Browser Maintains a... Started Automatic Local System
. ConfigMgr Task Sequence A, ConfigMgr ... Manual Local System
% Configuration Manager Rem...  Provides th.. Disabled Local System -
\ Extended /(Standard/

Stop the Command Media Archiver service.

Important: Ensure that the previous instance of the Command Media Archiver is stopped and
that the old program is uninstalled or disabled.

Find the install path for the new version of the Command Media Archiver that you installed in
step 1 of this restore procedure, for example:

<New Install Drive>\Command Media Archive\

Replace the files in the new install path of the new version of Command Media Archiver with the
backup files that you saved in step 3 of the backup procedure.

See “Backing up the Command Media Archiver” on page 22.

Replace the new files in the transaction, media and/or image paths with the backup files you
saved in step 4 of the backup procedure.

If necessary, edit the config.json file (found in <New Install Drive>\Command Media Archive)
so that the transaction, media and/or image paths lead to the locations configured for the new
version of the Command Media Archiver.

Restart the Command Media Archiver service.

The Command Enterprise Software updates the Media Archiver entry with the latest IP address
and hostname.
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Upgrading the Command Media Archiver

You can upgrade your Archiver if a new version is available to you.

To upgrade the Command Media Archiver
1 Open the new upgrade version of the CommandMediaArchiver_<version number>.exe file.
The Command Media Archiver Setup wizard appears, with the License agreement for you to read.
2 Select the check box to agree to the license terms and conditions.
You must select this check box to continue.
3 Click Install.

The Setup Progress page appears, with a progress bar, and initiates the appearance of the
Welcome page. Note that the Welcome page appears on top of the Setup Progress page.

4 Click Next.
The Modify Video Archive Size page appears.

1) Command Media Archiver Setup o] o)
Modify Video Archive Size »

Optionally increase the size of the video storage archive.

The Video Archive is a pre-allocated area that stores case or incident related video data.
Additional disk space outside this area may be required for images and recorder log fles.
Refer to the user documentation for quidance on selecting a Video Archive size.

You currently have 5GE in C:\Command Media Archive\ allocated for video storage. You
can retain this walue or increase it.

Video Archive Size: 5 GB

Selected Drive: 2\

10 @B of disk space from the selected drive is required in addition to the disk space
used to archive video.

Back [ MNext | [ Cancel

5 If you want to modify the size of the file storage archive, enter the new number (in GB) for the
size of the archive in the Video Archive Size box.

Important: You can increase the size of the archive or maintain it at the same size, but you
cannot reduce the size.

The amount of space you require for the Archiver Video Archive depends on various factors,
including what you are using the Archiver for (Transportation video, Case Management), the
length of time you want to retain video on the Archiver, the number of recorders and cameras in
your system, and the frequency of incidents.

If you are using the Archiver for Case Management as well as Transportation data, see the
Command Enterprise and Client User Guide for more information about storage requirements
for case management.

Click Next to show the Ready to install page.
7  Click Install to show the Installing page.
When the upgrade is complete, the Completed page appears.

8 Click Finish to show the previous Setup Progress page with a Setup Successful message, and
click Close to exit the Setup wizard.
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Adding the Transportation Application Rights to
the User Profile

After you have added the Transportation component to Command Enterprise, you must allow
users the right to view and use the transportation features. Do this by adding the Transportation
Application rights to the appropriate user profile.

Note: User rights in Command (including PTZ camera rights) are managed through the User
Profiles defined in Command Enterprise. For more information on Command User Profiles, see the
Command Enterprise and Client User Guide.

Any user whose profile includes user management rights can modify the name, description, and set
of rights associated with a profile.

When you make changes to a profile, all affected users are automatically logged out of the system
and will have to log back in.

Note: The steps to add the Transportation Application rights to the user profile are slightly
different if you are creating a new user profile instead of adding the rights to an existing profile.
For a new profile, the additional transportation rights (Create Incidents and Delete/Pause
Incidents) do not appear until you save the new profile with the main Transportation right
selected. See either:

* “Adding the Transportation Application Rights to an Existing User Profile” on page 25
+ “Adding the Transportation Application Rights to a New User Profile” on page 26

Adding the Transportation Application Rights to an Existing User Profile

The following procedure describes how to add the transportation application rights to an existing
user profile.

For a new user profile, see “Adding the Transportation Application Rights to a New User Profile” on page 26.

To add the transportation application rights to an existing user profile
1 Click the main menu and select User Management.
The User Management tab opens with the Users subtab open by default.

2 User Management * -

Profiles ~ Users Local Groups

L BOE R e s

Name T |Status ¥ | User Name T | Profile T | System Territory ¥ | Logical Temitory ¥ | Type ¥ | Certificate 7 | State T
+ A adminadmin  Enabled  admin Super Administrator Profile  System Logical LDAP User MNone

2 Click the Profiles subtab.
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3 Click the expand button to the left of the Profile Name of an existing profile.
The selected Profile page appears.

2 User Management L

Profiles Users  Local Groups

+ 3
T
Profile Name ¥ Description
- 1w Administrator An administrator of Command Enterprise.
Name General Rights Resource Rights Application Rights
+ Live Video « Server Logs System Tree .
Administrator o Vi Transportation
+ Archive Video « Additional Component Management tew
Description ~ Export to CME « Export to External Media © Edit + Create Incidents
An administrator of + Export to MP4 (H.264/AAC) « Evidence Vault Access O Hidgen + Delete/ Pause Incidents
Command Enterprise. Logical Tree
Media Deletion « Case and Tag Management go vi
iew
+ Take Snapshot Watermark @ Edt
v Audio @© None O Hidden
Q Always
+ Talk ) + Personal Tree M

4  Under Application Rights, select the Transportation check box to allow users to view the
Transportation tabs (Incident Archive and Incident Search).

You can further customize the transportation user rights with the additional rights that appear
under the main Transportation right:

* Select the Create Incidents check box to allow users to create new incidents (see “Creating
an Incident from the Incident Archive Tab” on page 52 and “Creating an Incident from the
Incident Search Tab” on page 95).

+ Select the Delete/Pause Incidents check box to allow users to:
— Delete an existing incident stored in the Incident Archive tab.

— Pause the download of an incident (scheduled extraction) or continue the download of
an incident in a paused state.

See “Incident Archive Tab User Interface” on page 39.
Note: When you make any changes, the Profile Name box is highlighted in orange.
5 On the Profiles subtab toolbar, click the Save All E button.

The Profiles subtab refreshes to show the changes. All users affected by the changes to that
profile are automatically logged out of the system. When they log back in, they have the right
to access the Command transportation features.

Adding the Transportation Application Rights to a New User Profile

The following procedure describes how to add the transportation application rights to a new user
profile.

For an existing user profile, see “Adding the Transportation Application Rights to an Existing User
Profile” on page 25.
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To add the transportation application right to a new user profile
1 Click the main menu and select User Management.
The User Management tab opens with the Users subtab open by default.

21 User Management * g

Profiles ~ Users  Local Groups

1t LB R aenes DR

Name Y | Status ¥ | User Name T | Profile ¥ | System Territory ¥ | Logical Temritory ¥ |Type ¥ | Certificate 7 | State T

+ A adminadmin  Enabled  admin Super Administrator Profile  System Logical LDAP User None

2 Click the Profiles subtab.
3 Click the Add a Profile button on the Profiles subtab toolbar.
The new profile appears in a modified state (highlighted in orange) on the Profiles subtab.

A8 User Management L A

Profiles *  Users  Local Groups
i H

Profile Name ¥ Description
- In

Name General Rights Resource Rights Application Rights
Naw Profile Live Video Server Logs System Tree Transportation
Archive Video Additional Component Management Q view
Description Export to External Media O Edt
® Hidden

Evidence Vault Access

Case and Tag Management Logical Tree

Take Snapshot ” Q view
ake Snapshof

P Waterma O kit

Audio ® None

4 Enter a new name for the profile in the Name box.

5 Select the General rights, the Resource rights, and the Layout you want to assign to the
new profile.

For more information on the General, Resource, and Layout rights, see the Command
Enterprise and Client User Guide.

In the Description box, type a description of the new profile.

7 Under Application Rights, select the Transportation check box to allow users to view the
Transportation tabs (Incident Archive and Incident Search).

Application Rights

Transportah'on
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8 On the Profiles subtab toolbar, click the Save All [§] button.
The new profile appears in the Profile Name column (Profiles subtab).

An User Management

Profiles  Users  Local Groups
+

g ™M

Profile Name ~ ¥ | Description

2 Administrator An administrator of Command...
2 Guard Access to monitor live, control PTZ...
2 Maintainer Sufficient rights to maintain system.

+ I Transportation Profile  Sample transportation profile.

s

9 Click the expand button to the left of the new Profile Name.

The new Profile page appears. Under the main Transportation right, there are now two
additional rights: Create Incidents and Delete/Pause Incidents.

* X + -
Profiles ®*  Users  Local Groups

& H
Profile Name

- I

2s User Management

T | Description

Sample transportation profile.

Name General Rights Resource Rights Application Rights
v

Transportation Profile + Live Video S S EIES + Transportation
+ Additional Component Manzgement O view

Description ¥ Archive Video ' Export to External Mediz @© Edit Create Incidents
. . Hidd
Sample transpartation profile, + Export to CME Evidence Vault Access U Delete / Pause Incidents
Logical Tree
Export to MP4 (H.264/aaC) ¥ Case and Tag Management O view
Wat rk .
Media Deletion £rma @ Edit
® None
O Hidden
+ Take Snapshot Q Always

You can further customize the transportation user rights with these additional rights:

* Select the Create Incidents check box to allow users to create new incidents (see “Creating
an Incident from the Incident Archive Tab” on page 52 and “Creating an Incident from the
Incident Search Tab” on page 95).

+ Select the Delete/Pause Incidents check box to allow users to:
* Delete an existing incident stored in the Incident Archive tab.

* Pause the download of an incident (scheduled extraction) or continue the download of
an incident in a paused state.

See “Incident Archive Tab User Interface” on page 39.

Note: When you make any changes, the Profile Name box is highlighted in orange.
10 On the Profiles subtab toolbar, click the Save All E button.

The Profiles subtab refreshes to show the changes.
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Defining Available Resources for a User

To use all the Transportation features, users require access rights to one or more recorders in the
System tree (available resources in the System Territory). Users can only see recorders they have
access rights to.

If users have Logical tree access only, they only have access to the Incident Archive tab: the
Incident Search tab is not accessible or visible. The Logical tree contains cameras not recorders, so
users only have access to the cameras assigned to them in the Logical tree.

For more information on creating users and defining resources in Command, see the Command
Enterprise and Client User Guide.

Note: User activity audit logs and device (recorder) audit logs are available to view and save from
Command Enterprise. For more information, see the Command Enterprise and Client User Guide.

To define available system and logical resources for a user

1 Click the main menu and select User Management.
The User Management tab opens with the Users subtab open by default.

2 On the Users subtab, click the expand + button to the left of a selected user.
The User Information page appears.

3 To define the user resources, click a folder (containing one or more mobile recorders) that you
want the user to have access to in the Navigation panel, then drag and drop that folder to the
System or Logical box in the Available Resources section of the User Information page.

If you do not want a user to have access to the entire System and/or Logical tree, you can
assign one or more subfolders from the System and/or Logical tree to a user or group’s
available resources. This allows you to customize user access. For example, if your recorders
are divided into four different subfolders, you can assign two subfolders to User A, and the
other two subfolders to User B. Four lower level users are assigned one subfolder each.

Note: For full Transportation access, users must have access to one or more recorders @ in
the System tree. Users with only Logical tree access (no System tree resources) can access the
Incident Archive tab (for assigned cameras), but not the Incident Search tab.

Top-level users are assigned full root level access to both the System tree and the Logical tree.
This grants top-level users access to Transportation settings and recurring incidents that lower-
level users cannot access.

For example:

* To grant full access to all recorders, click and drag the root System folder to the System
box (under Available Resources) on the selected User Information page, and release the
mouse button to drop it in the box.

Available Resources

" s @ st
3 [j] 01 Transpo [\/\ﬁ System I\,\ﬁ .
1~ 02 Transpo > Drop Not Allowed .
v B3 03 Transpo = Drop System to Available Resources

Note: While you are dragging the resource, the interface informs you that a drop is not
allowed until you move over the correct Available Resources box.
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* To grant partial access to a recorder or group of recorders in a folder, in the System tree,
click a subfolder that contains one or more recorders, and drag it to the System box.
You can add more than one System subfolder to the available resources of a user.

+ B3 System
- 3 01 Transpo
» 5 PV_GT20_Mobile1
» = py_GT20_Mobile2 Ikﬁ 01 Transpo
» = PV_GT20_Mobile2 X Drop Mot Allowed
» [ Py_MT06_Mobile1

v B 02 Transpo

Available Resources

& st
Dﬁ 01 Transpo

= Drop 01 Transpo to Available Resources

* To grant full access to the cameras and views (grid of multiple cameras) in the Logical
tree, click and drag the root Logical folder to the Logical box (under Available Resources)
on the selected User Information page, and release the mouse button to drop it in the box.

* To grant partial access to a camera, group of cameras, or view (grid display of multiple
cameras) in a folder: in the Logical tree, click a folder that contains one or more cameras
and/or views, and drag it to the Logical box.You can add more than one Logical subfolder.

Y Logical

~ B4 Logical
T
- Cameras
1 L % Logical Select All
22 Driver View c
I\'ﬂﬁ ameras
& IP Camera 3 Rﬁ Cameras

X Drop Not Allowed
¢ IP Camera 4

¢ IP Camera 5

= Drop Cameras to Available Resources

The folder and path names appear in the System and/or Logical box, and the folder name
appears in the System Territory and/or Logical Territory columns. When multiple folders are
added, the complete path for each folder is displayed in the column, separated by semicolons.

A& User Management NEE s

Profiles = Users Lol Groups

Sy BOE A e

Name - Y Status ¥ | User Name T | Profile ¥ | System Territory ¥ | Logical Territory ¥ Type T |Cerificte ¥

— L sample User Engbled  Sample User  Administrator 01 Transpo Logical/Cameras; Logical/Views Local User Mone
User Information

User Name Sample User Profile Transportation Profile -
Full Name Sample User Status  Enabled

Email Address user@email.com

Telegram User Name Certificate None
Phone 555-123-43567

Position Employee

Manager admin Password [[8p=L0 ] Force change on next login

Available Resources

@ sy e togia

B Systern/01 Transpo

Logical/Cameras

[
E3 Logical/Views

4 On the Users subtab toolbar, click the Save All E button.
The selected user can access only those resources within the defined folders.
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Welcome to Command Transportation

Settings for Transportation Configuration

In the Command Client, a user with top-level access can configure the general settings for
Transportation, such as the timeout period for incident upload, and data retention periods.

Note: The Transportation settings are only available to top-level users with full access to the root
System folder and the root Logical folder (see “Defining Available Resources for a User” on
page 29). The Transportation > Settings menu option is not available if you are not a top-level user.

To configure the Transportation settings
1 Click the main menu and select Transportation -> Settings.
Note: This option is only available to top-level users (full root System and Logical folder access).

? Help

9 Transportation , = Incdent Archive

@ Incident Search
%] Logout

The Settings tab opens.
h/ A 5 10.53.104.132
’v C daire
NAVIGATION EVIDENCE = O Settings
General Settings
Incdent Upload Timeout 14 days
Purge Incident After 120 days

+— [ HADVR1
1 ' HAGPS ) Purge Incident Search Data After  [EUEN]

% Logical

Personal

~— 3 Personal

HEALTH @) ALARMS () EXPORT

Device T | Source ¥ | Issue Category ¥ | Issue ¥  State T | Threshold T | Handled By ¥ | First Occurrence Last Occurrence

(== HAGPS Peripheral GPS Signal Lost v Not Handled  22/01/2023 2:49:54 PM  26/01/2023 9:34:15 AM
=] HAGPS Video Camera Disconnected v Not Handled  22/01/2023 6:04:18 PM  23/01/2023 2:48:28 PM
(== HAGPS Unit Local Login Enabled v Not Handled  23/01/2023 11:13:10 AM  23/01/2023 2:43:36 PM
(== HAGPS Video Stream Failed A Not Handled  22/01/2023 2:36:51 PM  23/01/2023 2:32:07 PM .

v
10 items (0 items filtered)

2 Alter the general settings to suit your needs. The following table describes each setting.

Setting Description

Incident Upload The amount of time that the Media Archiver waits to receive video from an
Timeout incident extraction before it times out and the incident fails.

For example, when an incident is created, video is downloaded from a transit
recorder and saved to the Media Archiver. If this is set to 14 days, the system
waits 14 days before the incident fails because it cannot download the video
from the recorder.

This timeout must allow for the fact that transit recorders are located on
vehicles that are not always available for video download.
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Setting

Description

Purge Incident
After

This is the retention period for Incidents — the period of time that the Media
Archiver stores incidents and displays them in the Incident Archive page
before deleting them.

After an incident is purged, you can no longer access it.

For more information on incidents, see “Using the Incident Archive” on
page 51.

Purge Incident
Search Data After

This is the retention period for search data — the period of time that the
system stores data used in the Incident Search page before deleting it.

For example, if this value is set to 30 days, you can use the Incident Search
page to find results during the last 30 days. Searching in an older time period
(greater than 30 days) will not produce any results.

For more information on the Incident Search, see “Using the Incident Search”
on page 86.

Note: The upper limits of these settings are controlled by custom properties in the Advanced
tab of the Enterprise Console. See the Command Enterprise Installation Guide for more

information.

3 Select the Save m button.



Welcome to Command Transportation

Preferences for Transportation Features

After you install the Transportation component, additional preferences are added to Command
Enterprise, to allow you to configure the extra features for mobile recorders. You can adjust the
additional preferences using the following procedure.

A user must have the Transportation rights to view these preferences (see “Adding the
Transportation Application Rights to the User Profile” on page 25).

Note: These additional preferences are also available in Command Client when connected to a
single RideSafe series recorder through the Command Client interface.

To change the transportation related preferences
1 Click the main menu and select Preferences.

x Tools »
# Preferences

De
! Layout 3

The Preferences tab opens.

L S

Scheduled Notifications

'ﬂ' Preferences

Client System Real Time Notifications  Keyboard Associations  Alarm Monitoring ~ Global

Language and Region

Language Autodetect

Time Zone Settings Device Time Zone

UI Customization )
Digital Zoom
Zoom Assistant
Display Extended Digital Zoom Toolbar
Display Timeline
B Open Timeline Automatically
Display Video Cell Options
Change Resolution
Recording Sector
PTZ Toolbar
Text Area Settings
Playback Start Point Second(s) Earlier
Il Return to Live Video After — Minute(s)
B Preserve Playback State On Drag & Drop

I Display Media Cell Header in Single Line Format
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Main Layout
Il Save Layout at Logout
Restore Layout at Login
Audio
Auto-Release Talk Channels After  [ERUII

Il Mute Stream Audio

Snapshot Export

Il Disable Timestamp on Snapshot

Alarm Behavior

Sound Played on New Alarm

<None> ~ g

@ Open Archive and Live Stream

Alarm View Display Behavior
@ Open Archive
O Open Live Stream

Il Open Info Panel for alarm

Transportation Options
Open GPS Panel automatically

GPS speed unit of measurement

Il Force download log from archiver




2 All the default Command Enterprise preferences remain the same, and are described in the
Command Enterprise User Guide (available from the March Networks Partner Portal website, or
from the Help menu item in Command Enterprise).

For Transportation, the Transportation Options section is added, with three new preferences:

+ Open GPS Panel automatically — If you select the check box, when you open a video media
cell, a view, or an incident tab, the GPS map panel is shown by default.

If this check box is not selected, you must click the Show GPS Information button to
display the GPS map.

Note: If there is no associated GPS information, the map panel is blank.

* GPS speed unit of measurement — Select from the list to show the GPS speed in miles per
hour (mph) or kilometers per hour (km/h). The GPS speed of the vehicle is displayed on the
GPS panel.

* Force download log from archiver — This check box controls the system behavior when a
recorder log file is requested from Command Client (right-click a recorder in the System
tree and save the device logs).

* If you select the check box, the log file is always downloaded from the Archiver rather
than directly from the recorder. By avoiding downloads directly from the recorder, you
avoid data transfer through cellular or wireless networks.

* If this check box is not selected, Command Client downloads the logs from the recorder
if it is available (mobile recorder is near the wireless access point), or from the Archiver
when the recorder is not available (mobile recorder is out of reach).

3 Click the Save All m button in the upper left corner of the Preferences tab to save your
changes.

Time Format

The time format (24-hour format or 12-hour AM/PM format) displayed in the Command
Transportation Incident Archive tab is determined by the settings of the computer where your
Command Client user interface is installed. If the computer’s operating system is set to display the
time in the 24-hour format, the Incident Archive tab displays the incident times in the 24-hour
format. If the computer is set to the 12-hour AM/PM format, the incident times display in the
12-hour AM/PM format.

If you change the time format while the Command Client user interface is open, you must close the
application and open it again to reflect the time format change in the Incident Archive tab.



Chapter 2

Understanding the User Interface

This chapter gives an overview of the Transportation interface in Command Enterprise, including
the Incident Archive tab, Incident Search tab, and the GPS maps.

Important: The transportation component (including the Command Media Archiver, the Incident
Archive tab, and the Incident Search tab), is an application added to the Command Enterprise
client, and appears as a menu option / tabs in the Command Enterprise client. For complete
instructions on how to use the Command Enterprise client, see the Command Enterprise and Client
User Guide, available from the March Networks Partner Portal website, or from the Help menu item
in Command Enterprise.

This chapter contains the following topics:

*«  “Overview” on page 36

* “Incident Archive Tab User Interface” on page 39

*  “Incident Search Interface” on page 43

*  “GPS Map User Interface” on page 46

“Incident Video and GPS Data Media Controls” on page 48
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Understanding the User Interface

Overview

The Command Transportation component consists of two main tabs within the Command Client
user interface (when connected to Enterprise): the Incident Archive tab and the Incident Search
tab. In addition, you can open an incident tab to view video from an individual incident.

The Incident Archive tab contains a list of all the incidents that are automatically and manually
downloaded. An incident is automatically created by alarms configured on the vehicle, for example,
when a bus stops suddenly (measured by an accelerometer), this can automatically trigger the
system to create an incident, so that you can view the video and data from that time, and find out
why and where the vehicle braked suddenly. You can also manually create an incident from the
Incident Archive tab, allowing you to choose the recorder, cameras, and time period that you want
to download video and data from.

The Incident Search tab allows you to search the video and data from the RideSafe Series recorders
in all your vehicles to look for specific incidents.

The incident tab displays when you open an incident from the list in the Incident Archive tab, and
displays the video and GPS map (if available) from the time of the incident.

When you add the transportation application to Command Client, the GPS map functionality is also
available for live mobile video streams (if GPS equipped). When you open a live camera stream that
has GPS information, a GPS map is available, and the vehicle route, speed, and position are shown
on the map.

Command Enterprise Client with the three Transportation tabs:

Command Navigation Transportation
panel tabs

Y = s 3.104.132
'. COMMAND 10.53.104.13:

daire
NAVIGATION EVIDENCE T E* Inddent Archive “lar|=

e rercr: [ ETE] : 0
, D7 Inddent Created Usemame T | vehide ID ¥ | InddentName ¥ | Incident Start  Incident End | Duration Extr ¥ |Progress ¥ | Purger ¥ Completi Type ¥ | Path
28/02/2023 0:02:28 AM (@5 Sav-GTDVR Impact Alarm 28/02/20238: 28/02/20238 00:00:30
28/02/2023 9:00:20 AM (E5/ Sav-GTDVR Hard brake 28/02/2023 8; 28/02/20238 00:00:30
28/02/2023 8:58:18 AM (®=) Sav-GTDVR Impact Alarm 26/02/20238: 26/02/20238 00:00:30
28/02/2023 8:56:15 AM (@5 Sav-GTDVR Operator Alarm  28/02/20238: 28/02/20238 00:00:30

LN

28/02/2( Auto System/RS5 Mabile
28/02/2( Auto System/RS Mabile
28/02/2( Auto System/R5 Mobile
28/02/2( Auto System/RS5 Mabile
28/02/2( Auto System/RS Mabile
28/02/2( Auto System/R5 Mobile
28/02/2( Auto System/RS Mabile
28/02/2( Auto System/R5 Mabile
28/02/2( Auto System/RS5 Mabile
28/02/2( Auto System/RS Mabile

28/02/2023 8:54:00 AM [#2) Sav-GTDVR Hard brake 28/02/20238: 28/02/20238 00:00:30
28/02/2023 8:50:30 AM (=) Sav-GTDVR Impact Alarm 28/02/20238: 28/02/20238 00:00:30
28/02/2023 8:48:29 AM @2 S3v-GTDVR Operator Alarm  28/02/20238: 28/02/20238 00:00:30

% Logical
Logical

28/02/2023 8:47:42 AM (@9 Sav-GTDVR Rear Door 28/02/20238: 28/02/20238 00:00:30
#i Personal 28/02/2023 8:46:11 AM [#2) Sav-GTDVR Hard braks 28/02/20238; 28/02/20238 00:00:30

LANALNANAN s
T

v &3 Personal 28/02/2023 8:42:21 AM (=) Sav-GTDVR Impact Alarm 28/02/20238: 28/02/20238 00:00:30
a5 Default View =

3 456 7 8 9 10 » W
HEALTH 0 ALARMS @ EXPORT
Device T |Source T | Issue Category ¥ | Issue T |state T |Threshold ¥ Handled By ¥ | First Occurrence ¥ |Lastoccurence ¥ | Count ¥ | Desaription

HAGPS  Peripheral GPS Signal Lost Not Handled  22/01/20232:49:54 PM  26/01/2023 9:34:15 AM 78 GPS Signal Lost.
GPS1  Video Camera Disconnected Not Handled  22/01/2023 6:04:18 PM  23/01/20232:48:28PM 11 Audio connection failed.
HAGPS  Unit Local Login Enabled Not Handled  23/01/2023 11:13:10 AM  23/01/20232:43:36 PM 6 This device has local user login enabled
HAGPS  Video Stream Failed Not Handled  22/01/20232:36:51 PM  23/01/20232:32:07 PM 9 There is 2t least one stream that is not working.
Camera5  Video Camera Disconnected Not Handled  23/01/20238:26:49 AM  23/01/20232:31:43PM 9 Camera connection failed.

.
5 items (0 items filtered)

Command Dashboard (Health, Alarm, and Export information)
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Understanding the User Interface

The Incident Archive tab:

Extraction buttons List of incidents extracted from recorders

Ew Inddent Archive BIEEE

QI LG A Past 7 Days

ID ¥  Inddent Created Usemame T | Vehide ID ¥ | Inddent Name ¥ | Incident Start | Incident End | Duration |Exir ¥ |Progress ¥ | Purger ¥ | Complet Path

7608  28/02/2023 9:02:28 AM 5 GTDVR  Impact Alarm 28/02/20238: 28/02/2023€ 00:00:30 28/02/2( Auto  System/RS Mobile

7607  28/02/2023 9:00:20 AM 5 GTDVR  Hard brake 28/02/2023 8: 28/02/2023 8 00:00:30 o 28/02/2( Auto  System/RS Mobile

7606  28/02/2023 8:58:18 AM @5 GTDVR  Tag Alarm 28/02/2023 8: 28/02/2023 8 00:00:30 28/02/2( Auto  System/RS5 Mabile

7605  28/02/2023 8:56:15 AM 5 GTDVR  Operator Alam  28/02/20238: 28/02/20238 00:00:30 28/02/2( Auto  System/RS Mobile

7604  28/02/2023 8:54:00 AM 5 GTDVR  Hard brake 28/02/2023 8: 28/02/2023 8 00:00:30 o 28/02/2( Auto  System/RS Mobile

7603  28/02/2023 8:50:30 AM @5 GTDVR  Impact Alarm 28/02/2023 8: 28/02/2023 8 00:00:30 28/02/2( Auto  System/RS5 Mabile
J

28/02/2023 8:48:29 AM Operator Alarm 28/02/2023 8: 28/02/2023 8 28/02/2( System/RS5 Mabils

Page buttons

The Incident Search tab:

Map, showing vehicle routes from the search results

= Time Period
H

Vehide Id

GT20_Mobile_1 .
GT20_Motile_2 Configurable search

GT20_Mobile_3 parameters
GT20_Mobile_4

moe R
=

RESET = SEARCH

Search Result: 23/02/2023 12:00 AM - 23/02/2023 11:59 PM (3) g

vehide Id T | Start Time End Time MaxSpeed ¥ Event Count T Above Speed Count T

GT20_Mobile_1  23/02/2023 12:34:40 PM | 23/02/2023 11:58:26 PM 52.82mph /2

GT20_Mobile 3 23/02/20239:13:30 AM  23/02/2023 11:59:06 PM 65.68mph I/ Search Result list
GT20_Mobile 4 23/02/2023 12:00:22 AM 23/02/2023 8:28:56 AM  68.10 mph
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Understanding the User Interface

An Incident tab:
GPS map, showing the route during

Views from cameras on the vehicle
the time of the incident

during the time of the incident

E* Incident Archive * BB Inddent from_Device March™ 4 -
SIS T ol o

25{01/2021 11:15:07 AM

COn
= Edinger Ave é\\

1P Camera 1 11:15:07 8M g 1P Camera 5 1LI5:07 AM 18
= MardsovR P e X | ™ e P = X | 1 MarchRSDWR

Huntington Beacl
@ F

o
Monday, Jandary 25 Manday, January 25
15‘;: 125

A live camera tab with GPS map:

Live view from camera on the vehicle GPS map, showing vehicle route

¢ IP Camera 2 X - =
System ~ DVR -~ Ma/chRSDVR  IP Camera 2 a B &g v H'r e
26/01/2021 11:15:51 AM

m¢ IP Camera 2 11:15:52 AM
MarchRSDVR 26/01/2021

%f%i‘g&smﬂr

- Buckrel Rd

I EIGWNOS -

air.

B
%
L
o

Naszau Rd

‘.

" R -4

z ! E
! =

]

' 5 L
g % s
'@a %’Q ‘%-‘Fulane Rd

Brooikkine Ln
Wake ForestRd /
o 5 /
= 47
=
= |

Joann 5t
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Understanding the User Interface

Incident Archive Tab User Interface

The Incident Archive tab displays a list of incidents: automatic, recurring, and scheduled
incident extractions from transit recorders. It allows you to extract an incident (video,
audio, and GPS data) from a transit recorder. The incidents you extract are added to a list
in this tab. You can pause the download of an incident during extraction, and delete an
incident from the list when you no longer need it.

Note: To access the Incident Archive tab, a user must have the Transportation application right in
their user profile (see “Adding the Transportation Application Rights to the User Profile” on

page 25). For more information on user profiles and user rights, see the Command Enterprise and
Client User Guide, available from the March Networks Partner Portal website, or from the Help
menu item in Command Enterprise.

To access the Incident Archive tab
1 Click the main menu and select Transportation -> Incident Archive.

? Help

v Transportation y =# Incdent Archive

ﬁ) Inddent Search
ﬂ Log Out Settings

The Incident Archive tab opens.

Y. SRR

NAVIGATION EVIDENCE § Ew Inddent Archive X 4 -

+ x 2 e e (TR o

_ ¥, 1D ¥ Incdent Created Usename ¥ |VehideTD ¥ | InddentName ¥ | IncidentStart  IncdentEnd | Duration |Extr: ¥ |Progress ¥ | Purger ¥ | Completi| Type ¥ |Path

¥ System -

~ @3 System i 28/02/2023 9:02:28 AM (#5) Sav-GTDVR Impact Alarm 28/02/20238; 28/02/20238 00:00:30 o 28/02/2( Auto  System/RS Mobile
= acs 28/02/2023 9:00:20 AM (=) Sav-GTDVR. Hard brake 28/02/20238: 28/02/20238 00:00:30

<

28/02/2( Auto  System/RS Mobile
»- @5 HADVR1 28/02/2023 8:58:18 AM (=) Sav-GTDVR Impact Alarm 28/02/20238: 28/02/20238 00:00:30
+ - hacps - 28/02/2023 8:56:15 AM (=) Sav-GTDVR Operator Alarm  28/02/20238: 28/02/20238 00:00:30
28/02/2023 8:54:00 AM (=) Sav-GTDVR. Hard brake 28/02/20238: 28/02/20238 00:00:30

28/02/2( Auto System/R5 Mobile
28/02/2( At System/RS Mobile
. 28/02/2( Auto  System/RS Mabile
il = 28/02/2( Auto System/R5 Mobile
28/02/2( Auto  System/RS Mobile

LSLSLSLNENEN

28/02/2023 8:50:30 AM () Sav-GTDWR Impact Alarm 28/02/2023 8: 28/02/20238 00:00:30
- Ea Logical

28/02/2023 8:48:29 AM (9 Sav-GTDVR Operator Alarm  28/02/2023 8:
# Personal - . = I g o "

HEALTH o) ALARMS @) EXPORT

Device ¥ |Source ¥ | Issue Category ¥ | Issue ¥ |State ¥ | Threshold ¥ | Handled By ¥ | First Occurrence ¥ |LastOcourence ¥ Count ¥ | Description
Peripheral GPS Signal Lost v Not Handled  22/03/20232:49:54 PM  26/03/2023 9:34:15 AM 78 GPS Signal Lost.
Video Camera Disconnected  +/ Not Handled  22/03/2023 6:04:18 PM  23/03/20232:48:28 PM 11 Audio connection failed.
Unit Local Login Enabled v Not Hendled  23/03/2023 11:13:10 AM  23/03/20232:43:36 PM 6 This device has local user login enabled.
Video Stream Failed A Not Handled  22/03/20232:36:51PM  23/03/20232:32:07 PM © There s at least one stream that is not working.

4 items (0 fems filtered)

The following table describes the buttons and table columns available on the Incident Archive
tab.

Button/Column | Description

Time Period

(=R = gy i Past 7 Days

Select a time period from the list provided, or choose Select Range to open a
calendar and set you own time period.

Search
Click to search for incidents filtered by the time period selected.
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Button/Column

Description

Create Incident

Click to open the Add Scheduled Incident Extraction dialog, which allows you to
create an incident by specifying a name for the incident, selecting a mobile recorder
to download from, selecting the cameras you want video from, and the date and time
period of the incident.

A user must have the Create Incidents user right in order to create a new incident
(see “Adding the Transportation Application Rights to the User Profile” on page 25).

Delete Incident(s)

After selecting an incident (scheduled extraction) from the list, click to delete the
incident.

A user must have the Delete / Pause Incidents user right to delete an incident (see
“Adding the Transportation Application Rights to the User Profile” on page 25).

Recurring Incidents
Manage (add, edit, delete) recurring incident extractions.

A recurring incident is an automatic extraction that occurs at a specified time each
day, for the specified recorders. You can create multiple recurring incidents, at
different times and applicable to different recorders.

You can enable/disable each scheduled recurring incident.

Users require the Create Incidents user right in order to create a new recurring incident
(see "Adding the Transportation Application Rights to the User Profile” on page 25).
Users also require top-level access: full access to the root System folder and the root
Logical folder (see “Defining Available Resources for a User” on page 29).

Play Incident

After selecting an incident (scheduled extraction) from the list, click to play the video
from the incident.

Pause Incident

After selecting an incident (scheduled extraction) from the list, click to pause the
download of the incident.

Also use this button to continue a download that is paused. A user must have the
Delete / Pause Incidents user right to pause an incident (see “Adding the
Transportation Application Rights to the User Profile” on page 25).

Note: You can only pause an incident that is in the progress of downloading
(progress bar shows less than 100%).

Retry Incident

If the creation of an incident fails, this button becomes available and you can retry the
download of the video and related information to successfully create the incident.

My Incidents
Click to view only incidents created by you.
Your user name appears in the User name column for the incident.




Button/Column

Description

Refresh Incident List

When a new incident is created, this button becomes available and displays the
number of new incidents that have been created but not added to the list.

Click this button to refresh the list and display the latest incidents.

Page buttons
By default, 30 incidents are displayed on a page in the Incident Archive.
If there are multiple pages you can navigate to the other pages using these buttons.

An identification number for the incident.

Incident Created

The date and time that the incident was created.

Username

The name of the user that created the incident.

Vehicle ID

The ID name/number of the vehicle where the incident data was downloaded from.

Incident Name

The name of the incident.

Incident Start

The date and time that the incident starts.

Incident End The date and time that the incident ends.

Duration The duration of the data in the incident.

Extraction Extraction Status. The download status of the incident extraction.
Status

Waiting — Waiting for the Incident creation to begin.

11 Active — The Incident is in the process of creation.
] Paused — The creation of the Incident is paused.

—_——

:__@ Pending — The Incident is created but not yet handled by the Archiver.

J Success — The Incident is successfully created and saved in the Archiver.
A Alert — There is a problem with the Incident creation.

Tip: You can hover your mouse over the icon to see additional information about the
status. For more details, see “Troubleshooting an Incident Extraction” on page 54.

Duration | Extraction Status T | Progress T
00:00:30 V|
Download successful

Progress

A progress bar to track the download of the incident data.




Button/Column

Description

Purged Tracks the retention of incidents.

After 120 days (default), incidents are purged to allow room for new incidents. The

column displays Purged and the incident becomes unavailable: you can no longer

open it.

You can delete purged incidents to remove them from the Incident Archive tab.

Completion The date and time that the system completes extracting the incident (all video and
Time related data) to the Media Archiver.
Type The type of incident, one of the following:

* Scheduled — An incident that is manually requested by a user by selecting
the Create Incident button in the Incident Archive tab.

See “Creating an Incident from the Incident Archive Tab” on page 52.

+ Automatic — An incident that is automatically created by an alarm (for example,
the Tag Alarm). When a physical alarm (such as a physical button that the vehicle
driver presses) is triggered, the system automatically downloads video and data
related to that alarm.

See “Automatic Incident Creation” on page 76.

* Recurring — An incident that is manually requested by a user and automatically
reoccurs every day at the same time. Recurring incidents are created and
managed by selecting the Recurring Incidents button in the Incident Archive tab.
See “Creating and Managing Recurring Incidents” on page 55.

Path The path of the recorder in the Command Enterprise System tree (see the System

tree in the Navigation panel).

Export Incident
Note: Button is under the incident list, at the bottom right.

Export the status data from all the incident extractions in the Incident Archiver page
to a CSV file.

See “Exporting Incident Data to a CSV File” on page 85.




Understanding the User Interface

Incident Search Interface

The Incident Search tab allows you to use relevant parameters to search the RideSafe Series
recorders in all your vehicles for specific incidents.

Note: To access the Incident Search tab, a user must have the Transportation application right in
their user profile (see “Adding the Transportation Application Rights to the User Profile” on

page 25). Users also require access rights to one or more RideSafe series recorders in the System
tree (available resources in the System Territory). Users only see results from the recorders they
have access rights to (see “Defining Available Resources for a User” on page 29).

For more information on user profiles and user rights, see the Command Enterprise and Client User
Guide, available from the March Networks Partner Portal website, or from the Help menu item in
Command Enterprise.

To access the Incident Search tab
1 Click the main menu and select Transportation -> Incident Search.

? Help 3

9 Transportation , = Incident Archive
= S Incident Search

ﬂ Log Out

The Incident Search tab opens.

H‘ =001 29/01/2017  [E1) 12:00 AM :
LR 29/01/2017  [E]f| 11:59 PM :
? Vehide Id

A W | vehide 1d
\ s, ¢
P AN N GT20_Mobile_1
< 4”%\\ P P GT20_Mohile_2
\ O o, GT20_Mabile_3
:

GT20_Mohile_4

R
M Search Above _ mph

RESET = SEARCH

-

Color Vehide Id ¥ | Start Time End Time Max Speed ¥ Event Count ¥ | Above Speed Count T

The following table describes the buttons and table headings on the Incident Search tab.

Tab Button Description
Home Location
n Click to return the map view to the location that you have set as your home
location.
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Tab Button

Description

‘ Otawa, Ontario, Canada ‘

Search

Type in the name of a location (city, town, street name, other location details) and
click Enter. The search bar offers suggestions as you type.

Set as Home Location

After you find the location on the incident search map that you want to designate
as your home location, click the menu button at the top right of the map and
select Set as Home Location from the menu.

You can now click the Home Location button to quickly and easily return to your
designated map home location.

Map Zoom
Click to open a scale allowing you to zoom in and out of the map.

Note: You can also use the scroll button on your mouse to zoom in and out.

Zoom to Fit
Click to fit the map size to the GPS route it is displaying.

Show Geofence

Click to draw a dashed-line frame box that encloses an area of interest on the
map. You can click and drag any of the four corners of the frame to change its
size and the area of the map that it covers.

Show Events
Click to show the events that you search for as icons on the map.

Note: Events are only shown on the map after a search successfully finds a result
including one or more events.

Use Default Map / Use Custom Map
Click to toggle between the default map and the custom map.

Note: This button is only available if your Client Map Policy is configured to allow
both default and custom maps. For more information on setting the Client Map
Policy, see the Command Enterprise Installation Guide.

¥ EHE O gE R »E

Time Interval Presets
Select from pre-configured time frames (past hour, today).

Time Period Either click the Time Period button (described above), or customize the dates and
times in the From and To boxes to configure your own time period.

Vehicle ID Click the check box of the vehicle ID that you want to search for, or click the
check box at the top to select all the vehicles in the list.

Event To search for an event, click the check box and select an event from the list. You

can select Any to search for all existing events.

Search Above

Click the check box and type in a vehicle speed. The search looks for any vehicle
that is recorded as traveling above the speed that you enter.

Note: The speed measurement (miles per hour or kilometers per hour) is set to
local parameters when the Transportation application is installed, but you can

change this in the Command Preferences (see “Preferences for Transportation
Features” on page 33).




Tab Button

Description

Reset the parameters for the incident search.

SEARCH

Perform a search using the current parameters.

[

Export Results
Export the search results to a CSV file.

Search Results Table

Create Incident

Click to open the Add Scheduled Extraction dialog.

When you open the Add Scheduled Extraction dialog from the Search results in
the Incident Search tab, the dialog is pre-configured with the parameters of the
selected result.

You can edit the incident download by selecting a different mobile recorder,
selecting the cameras you want video from, and changing the date and time
period of the incident.

The maximum duration for an incident download is 2 hours.

A user must have the Create Incidents user right in order to create a new incident

(see “Adding the Transportation Application Rights to the User Profile” on
page 25).

Color When you select a result in the Search Results list, this column shows the color of
the vehicle route when it is displayed in on the map.
For example, if the color column shows a green square, the vehicle route is shown
in green on the map.

Vehicle ID The ID of the vehicle found in the search result.

Start Time The time of the first appearance of the vehicle in the search result.

End Time The time of the last appearance of the vehicle in the search result.

Max Speed The maximum speed of the vehicle in the search result.

Event Count

The number of events found in the search result.

Note: If the Event check box is not selected in the search parameters, this column
is not applicable.

Above Speed Count

The number of times the vehicle exceeded the defined speed (in the Search
Above field) in the search result.

Note: If the Search Above check box is not selected in the search parameters, this
column is not applicable.




Understanding the User Interface

GPS Map User Interface

If GPS data has been included in your incident extraction, an interactive map with vehicle route,
speed, and position information is available in the incident tab.

The GPS map can appear in incident tabs (only available when Command Client is connected to
Command Enterprise), and in camera tabs, view tabs, and alarm view tabs (available when
Command Client is connected to Command Enterprise and/or when Command Client is connected
to a single RideSafe series recorder).

I8 WA GPs

2021-09-22 11:28:59 AM

The following table describes the buttons available on the GPS map, which allow you to configure
the appearance of the map.

Map Button | Description
Show/Hide GPS Map Panel
!ﬁ! Click to show/hide the GPS map. When the map is hidden, the incident shows the video only.

Map Zoom
Click to open a scale allowing you to zoom in and out of the map.

Note: You can also use the scroll button on your mouse to zoom in and out.

Zoom to Fit
Click to fit the map size to the GPS route it is displaying.

Lock to Center
This centers the map on the current position of the vehicle as it moves along the route mapped
by GPS.

Use Default Map / Use Custom Map
Click to toggle between the default map and the custom map.

Note: This button is only available if your Client Map Policy is configured to allow both default
and custom maps. For more information on setting the Client Map Policy, see the Command
Enterprise Installation Guide.
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Features of the GPS map
The following graphic displays some of the features of the GPS map.

21/01/2015 11:28:59 AM

Williamsville

GPS Map
configuration
buttons

Blue line shows
vehicle route

Blue circle

with white
arrow shows
vehicle progress
along route

Vehicle speed Vehicle position (direction, latitude, longitude)

Other features included with GPS:
* You can click and drag on the map to navigate to a different part of the map.
* Double-clicking on the map zooms in.

+ If you click the Video Options button and select Show Video Information from the menu,
the GPS data is displayed in each video cell.

IP Camera 1 8:20:12 AM
- >

11/8/2021

30 ips - 1987 kb/s
TP Camera 1 - 11/08/2021 8:20:12 AM
31mph, 66°NE, 42.9333783333333 N, 78.7238383333333 W GPS information
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Incident Video and GPS Data Media Controls

The Media Controls area is where you manage the available media using the timeline and the
media toolbar buttons.

~day, January 26 Monday, January 26
: :15|m ll.:.'-!ﬂlm 1].:.'-5I

» » » I3 O B @ B [l & 1 [ &

Note: For more information on the media controls, see the Command Enterprise and Client User
Guide, available from the March Partner Portal website, or from the Help menu item in Command
Enterprise.

Timeline

The Timeline is above the media toolbar. You can use the timeline, the playback cursor, and the
associated media buttons to control the video.

way, January 26 Monday, January 26

| M ‘l" 11:.-1*;I

Playback cursor

Note: The Visual Finder (a bar below the timeline that shows the current time period) is not
available when viewing video in an Incident tab.

Media Toolbar

The media toolbar contains buttons that allow you to control the video and GPS data.

» e [ B E & ] & = [ 2%

The following table describes the buttons in the media toolbar.

Button Tooltip Description

Show/Hide Timeline | Shows or hides the timeline.

Sector Selects the recording sector (if applicable).
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Button

Tooltip

Description

=,

F
W

Jump Back 10
Seconds

Activates instant replay.

This button allows you to jump 10 seconds back in the video, whether
you are in live or playback mode. In live mode the button also enables
playback mode.

You can also use the Instant Replay menu options (right-click on the
video image) to jump back 20 seconds, one minute, or five minutes.

Go To Start

In an Incident tab, shows the camera views, audio, and GPS data from the
beginning of the incident route.

Play Backwards

Note: Only available when you are in x2 or greater playback mode (after
clicking the Play Forward button). When you click the Play Backwards
button, the speed of the fast forward is decreased one level (for example,
from x4 speed to x2 speed).

Pause

Pauses video, audio, and GPS data playback.

Play

Plays the video, audio, and GPS data.

Play Forward

Fast forwards the video, audio, and GPS data.

Note: Click multiple times to increase the speed. When the playback is
paused, jumps to the following frame (frame-by-frame mode).

Go to End In an Incident tab, shows the camera views and GPS data from the end of
the incident route.
Go to Live Returns the video to live mode.

Note: Not available when viewing archive video from an extracted
incident.

Synchronize Grid

Allows you to synchronize the video from multiple video streams.

[#]

Timeline Find

Opens the date/time search panel.
See the Command Enterprise and Client User Guide for more details.

B EEO0OHBHEHRNMEBRB

Export Video

Exports the selected video evidence.
See the Command Enterprise and Client User Guide for more details.
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Button

Tooltip

Description

E

Delete Media

Deletes the selected video evidence (and related media).

Note: If you do not have the Media Deletion user right, this button does
not appear in the interface at all. If you do have the Media Deletion right,
the button appears, but is only available when there is video selected in
the timeline.

Take Snapshot

Takes a snapshot of the current image.
See the Command Enterprise and Client User Guide for more details.

Digital Zoom

Selects the area you want to zoom in.
See the Command Enterprise and Client User Guide for more details.

Select Area To
Zoom

Moves the zoom area. (Pan zoom.)
See the Command Enterprise and Client User Guide for more details.

Move Zoom Area

Fits the image to the current size of the display area.
See the Command Enterprise and Client User Guide for more details.

Real Image Size

Refreshes the image to show the original image size.

B EB O EE R

M

Fit To Window Fits the image to the window size.
Video Allows you to adjust the sharpness, brightness, and contrast of the video
Enhancements picture.

See the Command Enterprise and Client User Guide for more details.
Talk Channel Allows you to view a list of all the available talk channels, select the one

you want to use and turn it on to talk (and off when finished talking).

Adjust Volume

Controls the audio volume, if applicable.

If the video file contains audio, you can modify the audio volume or mute
the channel by clicking the Adjust Volume button on the timeline
toolbar. You can use the Audio slider to modify the volume or click the
Adjust Volume button below the slider to mute the channel.

Audio
Slider
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The Incident Archive tab allows you to download video and data from your recorders, and lists the
video and data as incidents.

It contains the following topics:

+ “Creating an Incident from the Incident Archive Tab” on page 52
* “Creating and Managing Recurring Incidents” on page 55

*  “Viewing My Incidents” on page 58

* “Searching for an Archived Incident” on page 59

*  “Playing an Incident” on page 61

*  “Using the GPS Map” on page 63

*  “Viewing Text Overlay” on page 66

+ “Exporting an Incident” on page 70

*  “Automatic Incident Creation” on page 76

*  “Navigating Multiple Pages and Blocks of Incidents” on page 78
+  "“Refreshing the Incident List” on page 78

* “Deleting an Incident” on page 78

*  “Deleting Selected Video from an Incident” on page 80

*  “Viewing Available Space on the Archiver” on page 83

*  “Ensuring the Archiver has Enough Space” on page 84

*  “Exporting Incident Data to a CSV File” on page 85

Note: Video and data listed in the Incident Archive tab is stored in the Command Media
Archiver, not on recorders. Retention limits on the Command Media Archiver are not the
same as on recorders. You can change the default retention period on the Command Media
Archiver if necessary (see “Changing the Default Purge Time Period” on page 84) and you
can manually delete incidents or selected video from the Command Media Archiver using
the Incident Archive tab (see “Deleting an Incident” on page 78 and “Deleting Selected
Video from an Incident” on page 80).



Using the Incident Archive

Creating an Incident from the Incident Archive Tab

The Incident Archive tab allows you to extract video evidence from mobile recorders. You can do
this by creating an incident, which consists of video, audio, and GPS data from a certain time
period of your choosing, downloaded from a mobile recorder on a vehicle. You create an incident in
order to extract and save video from a selected recorder and camera(s) at a selected time.

If a camera is associated with audio, audio is also automatically downloaded.

If the device has GPS data available for the selected time period, GPS data is automatically
downloaded.

Note: You can also create an incident from the Incident Search tab. For more information, see
“Creating an Incident from the Incident Search Tab” on page 95.

Required User Rights

To access the Command Media Archiver and view the Incident Archive tab, a user must have the
Transportation application right in their user profile. To create a new incident, a user must have the
Create Incidents user right. See “Adding the Transportation Application Rights to the User Profile”
on page 25.

For more information on user profiles and user rights, see the Command Enterprise and Client User
Guide, available from the March Networks Partner Portal website, or from the Help menu item in
Command Enterprise.

To create an Incident from the Incident Archive tab

1 Click the main menu and select Transportation -> Incident Archive.

? Help 3

v Transportation » =+ Inddent Archive

@ Incident Search
ﬂ Log Qut Settings

The Incident Archive tab opens.
W March N rks

. COMMAND
NAVIGATION EVIDENCE ¥ =% Incdent Archive ML E

Time percd: (RS E - & 1

+ X )
_ ¥  ID|Inddent Created Usemame ¥ | VehideID ¥ InddentMa ¥ | Incident St Incident En Dur | Extraction Status ¥ |Progress ¥  Purged ¥ | Completion Time Type ¥  Path

= o >
T M 10.53.104.132

-

»— [®=] HADVR1
+- o HAGPS

.
Y Logical

- Logical

# Personal

~— 3 Personal 1

HEALTH ¢ ALARMS () EXPORT
Device T Source T |Issue Category ¥ | Issue ¥ State ¥ Threshold ¥ Handled By ¥ | First Occurrence T | Last Occurrence T | Count ¥ | Description
Peripheral GPS Signal Lost vy Not Handled  22/01/2023 2:49:54 PM  26/01/2023 9:34:15AM 78 GPS Signal Lost.
Video Camera Disconnected J Not Handled  22/01/2023 6:04:18 PM  23/01/2023 2:48:28 PM 11 Audio connection failed.
Unit Local Login Enabled J Not Handled  23/01/2023 11:13:10 AM  23/01/2023 2:43:36 PM 6 This device has local user login enabl
Video Stream Failed A Not Handled  22/01/2023 2:36:51 PM  23/01/2023 2:32:07 PM @ There is at least one stream that isn -

v
10 items (0 items fitterad)
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2 Click the Create Incident
The Add Scheduled Incident Extraction dialog appears.

D’ Add Scheduled Incident Extraction

Inddent Name:

Camera Name

= Camera 7

T

o

~ = Camera 6
« md Camera 8
ol

4 P Camera 2

SRVl 01/01/2015 [R]f8:37 AM =i 21/01/2015 [3f 9:37 AM Interval: 01:00:00

Cancel

3 In the Incident Name box, type a descriptive name for the incident.
4 Select a mobile recorder in the Extract From list box.
This is the recorder installed in the vehicle where the incident occurred.
5 Select the check box for one or more cameras in the Camera list.
These are the cameras in the vehicle where the incident occurred.
6 Modify the Start and End date and time, as required.

This is the start and end time of the video and other data you are extracting. When you export
from multiple cameras, all the videos have the same start and end time. The Interval field shows
the length of the video with the selected start and end times.

The maximum duration for a scheduled extraction is 2 hours.

Note: If the selected timeline occurs during the Daylight Saving Time shift, a DST check box is
enabled. When selected, the DST period is included in the extraction.

7 Click Add.

A pop-up notification appears at the bottom of the incident list, indicating that the incident has
been created. You can click this notification to filter the list so that it only displays your
incidents (only incidents with your user name).

S Inddent Archive NEE S
Time Period: [EEarivEie] [l @« B E E O ] O
D Inddent Created Usem: T | Vehide ID T | Indident Name T | Inddent Start Inddent End Duration | Bxtraction Status ¥ Progress T | P

=

7027 26/02/2018 2:45:32 PM [ GTDVR Operator Alarm 26/02{2018 2:33:49 PM  26/02/2018 2:34:19 PM  00:00:30 v,
7026 26/02/2018 2:45:22 PM TechPub =2 GTDVR Techpub 26/02{2018 1:44:00 PM | 26/02/2018 1:54:00 PM  00:10:00 1] | am |
7025 26/02/2018 2:43:24 PM [ GTDVR Operator Alarm 26/02/2018 2:31:42 PM | 26/02/2018 2:32:12 PM  00:00:30 v,
7024 26/02/2018 2:42:23 PM [ GTDVR Hard brake 26/02/2018 2:30:41 PM  26/02/2018 2:31:11 PM  00:00:30 v,
7023 26/02/2018 2:40:14 PM [ GTDVR Impact Alarm 26/02/2018 2:28:32 PM  26/02/2018 2:29:02 PM  00:00:30 v,
26/02/2018 2:38:42 PM [ GTDVR Hard brake 26/02/2018 2:26:59 PM  26/02/2018 2:27:29 PM  00:00:30 v,

Incident created.

2 3 4 5 6 7 8 9 10 » »
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8 You can also click the Refresh button to view all the newest incidents, including the one
you just created, or the My Incidents button (see “Viewing My Incidents” on page 58).

9 Depending on factors such as the length of the video you are extracting, the availability of the
recorder you are extracting from (CES may have to wait for a bus to return to the Depot to
contact the mobile recorder), the incident extraction may take some time.

The Extraction Status column displays icons that help you track the progress of your incident
download. These icons and their meanings are listed in the “Incident Archive Tab User
Interface” on page 39 (see the table).

You can hover your mouse over the icon to see additional information about the status.

Inddent End Duration | Extraction Status ¥ Progress ¥  Purged 7
| 0% |

[ waiting for recorder connectio%‘

When your incident extraction is successfully completed, the Extraction Status column displays
the Success icon J indicating that the Incident is successfully created and saved in the
Archiver.

Inddent End Duration | Extraction Status T Progress T |Purged 7T

03/05/2012 2:09:10 PM  00:00:30 J
| Download successfulﬁ

Troubleshooting an Incident Extraction

If your incident fails to download and shows the red Alert icon, you can hover your mouse over
the icon to see additional information about why the download failed.

Duration | Extraction Status ¥ Progress ¥ (Purged ¥

Abwm

| Download failed: Timeout contacting record

Reasons for the download failure and alert messages include:

- Timeout contacting recorder

- No data found

- Unknown problem (Check Media Archiver and/or recorder health)

If your incident extraction fails to download and the hover text does not help you solve the
issue, you can contact March Networks Customer Support for assistance.
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Creating and Managing Recurring Incidents

In addition to creating a single incident, you can also create a recurring incident, which extracts and
saves video from all the available cameras on a selected recorder every day at a selected time each
day (or all day).

You can enable or disable the recurring incident, if you need to pause the recurrence.
You can edit or delete recurring incidents.

Note: To create a recurring incident you must be a top-level user with full access to the root
System folder and the root Logical folder (see “Defining Available Resources for a User” on
page 29). The Recurring Incidents button is not available if you are not a top-level user.

Important: Incident video and data is stored on the Command Media Archiver. Before setting up
recurring incidents, you must ensure that you have enough disk space assigned to the Media
Archiver, since daily recurring incident extraction increases the space requirements exponentially.
The Video Archive Size is allocated when you install or upgrade the Media Archiver (see
“Installing the Command Media Archiver” on page 17 and/or “Upgrading the Command Media
Archiver” on page 24).

Calculate disk space based on the number of active channels, resolution, bit rate, and frame rate.
For more information or assistance with Media Archiver storage calculations, contact your March
Networks Technical Support representative.

Creating Recurring Incidents

A recurring incident occurs every day at a specified time. The minimum time interval is one hour,
the maximum is all day.

To create a recurring Incident
1 Click the main menu and select Transportation -> Incident Archive.
The Incident Archive tab opens.

v’_ OMN ki 10.53.104132
NAVIGATION EVIDENCE ¥ S Incdent Archive X+ -
+ x 1 e e TR -
¥, ID| Incident Created | Us , ¥ | Vehide D ¥ | IncidentNa ¥ | Incident St| Incident En | Dur. | Extraction Status ¥ | Progress ¥ | Purged ¥ | Completion Time | Type ¥ | Path
'l System -
- 3 System
= AcEs
+- [®5 HADVR1
+- i HaGPs

Y Logical

- E3 Logical

#& Personal

~ 3 Personal 1

HEALTH ) ALARMS () EXPORT
Device T Source T |Issue Category T Issue T |State T  Threshold ¥  Handled By ¥ | First Occurrence ¥ | Last Occurrence T | Count ¥ | Description
Peripheral GPS Signal Lost v, Not Handled  22/01/2023 2:49:54 PM  26/01/2023 9:34:15 AM 78 GPS Signal Lost.
Video Camera Disconnected v, Not Handled  22/01/2023 6:04:18 PM  23/01/2023 2:48:28 PM 11 Audio connection failed.
Unit Local Login Enabled v, Not Handled  23/01/2023 11:13:10 AM  23/01/2023 2:43:36 PM & This device has local user login enabl
Video Stream Failed 'y Not Handled  22/01/2023 2:36:51 PM  23/01/2023 2:32:07 PM 9 There is at least one stream that isn -

v
10 items (0 items fittered)
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2 Select the Recurring Incidents button.
Note: This button is only available to top-level users (full root System and Logical folder access).
The Manage Recurring Incident Extractions dialog appears.

E‘I’ Manage Recurring Incident Extractions
+ X Extraction 1

T | Name ¥ | Desaiption E4 Enable extraction
Name

Extract
| FUDEEE Y 1:00PM -~ @D 2:00PM -

Recorders
Name T

El = wmnib1s4sa089
{Ed = mnib1azoas3o

Close

~  Extraction 1 13:00-14:00 - 2 Recorder(s)

3 Select the Add Recurring Extraction button.
A new recurring extraction is added to the list.

Manage Recurring Incident Extractions

=+ X New recurring extraction

M Enable extraction
Name

New recurring extraction
Extract
| FUDEa ] 12:00 aM  ~ [ 12:00 AM ~

Recorders

T | Name T | Desaiption

~  Extraction 1 13:00-14:00 - 3 Recorder(s)
New recurring extraction All Day - 0 Recorder(s)

Name

Drag & drop recorders here to add them to the recurring
extraction

4 Select the Enable extraction check box (also selects the check box beside the name of the
extraction in the list).

Note: You can leave this check box clear if you want to set up a recurring extraction but not
activate it immediately.

5 Enter a Name for the new recurring extraction (required and cannot be the same as the name of
an existing extraction).

6 Under Extract, select All Day if you want the extraction time interval to last all day.
Note: The From and To boxes become unavailable when you select All day.

7 Enter a time to start the extraction in From, and a time to end the extraction in To.
The minimum selectable time interval is one hour.

8 From the System tree in the Navigation panel, drag and drop the recorders that you want to
extract video from (at least one recorder is required).

9 Select the Save E button, then the Close button.
Note: The Revert Changes button allows you to revert unwanted changes before you save.

If the recurring incident is enabled, the extraction will start at the scheduled time. The incident
Type in the Incident Archive list will be Recurring.
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Editing or Deleting Recurring Incidents

You can edit or delete recurring incidents.

To edit or delete a recurring Incident
1 Click the main menu and select Transportation -> Incident Archive.
The Incident Archive tab opens.

W Marc s p ——
W ESMAGARES LR 1053108132

aire
NAVIGATION EVIDENCE ¥ &% Incdent Archive N

/] Time Period: [EEadeE] -l i 3 E
Y‘ ID T | Inddent Create User ¥ | Vehide ID T nt Name ¥ | Inddent Start | Inddent End | Duration Extract ¥ Progress ¥ Purg T | Completion Time Type
>

1920 20230309 3:0 5 MNAR1734m171 NeW recuring

extraction 2023-03-09 2: 2023-03-09 2: 00:39:59 Z 2023-03-09 3:32 Recurring

1010 2023-03-09 1:0 (B9 MNLD1430A530 2%5%”'“‘3 2023-03-09 1. 2023-03-09 12 00:50:50 2 2023-03-09 1:07 Recurring

»— [#3) HADVR1

f 1918 2023-03-09 12: 5 MNLD1430A530 NEW recurring 2023-03-09 1 2023-03-09 11 00:59:59 T 2023-03-09 12:1 Recurring
- HAGPS

extraction

% Looical
v 4 Logical

# Personal
~~ 3 Personal B

HEALTH o) ALARMS () EXPORT

Peripheral GPS Signal Lost v Not Handled =~ 2023-02-07 2:49:54 PM  2023-02-08 9:34:15AM 78 GPS Signal Lost.
Video Camera Disconnected v Not Handled  2023-02-21 6:04:18 PM  2023-02-27 2:48:28 PM 11 Audio connection failed.

Device Source T | Issue Category ¥ | Issue T | State T | Threshold T | Handled By ¥ | First Occurrence ¥ | Last Occurrence T | Count ¥ | Description I

Unit Local Login Enabled v Not Handled  2023-02-24 11:13:10 AM  2023-03-09 2:43:36 PM 6 This device has local user login enabl
Video Stream Failed A Not Handled  2023-02-28 2:36:51 PM  2023-03-14 2:32:07 PM 9 There is at least one stream that isn -

D
10 items (0 items filtered)

2 Select the Recurring Incidents button.
The Manage Recurring Incident Extractions dialog appears.

r'_rf Manage Recurring Incident Extractions

+ X (] Extraction 1

¥ | Name ¥ | Description 4 Enable extraction
Name

Extract
M AllDay From BRIGEZTEERS To ER]: TR

Recorders
Name

u () MINLDY1 5454089
{E] == MnD1430A530

~  Extraction 1 13:00-14:00 - 2 Recorder(s)
~  Sample extraction 11:00-12:00 - 1 Recorder(s)

3 Select the recurring incident you want to edit and alter the details as desired.

You can enable or disable the extraction, change the name, change the time interval, and add/
delete recorders.

4 You can also delete a recurring incident by selecting it in the list, then selecting the Delete
Recurring Extraction m button.

5 Select the Save E button, then the Close button.
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Viewing My Incidents

You can filter the list of incidents to display only your incidents: the incidents with the same user
name as the one you are currently logged into Command Client with.

When you create an incident, it does not immediately appear in the list of incidents. You can use
the pop-up notification at the bottom of the list to view your incidents, or you can use the My
Incidents button.

To view incidents that match the current user (My Incidents)
1 Open the Incident Archive tab.

S Incident Archive X 4 -

Time Period: [l ] 5 Irg e}

ID T | Incdent Created Username Y | Vehide ID T | Incident Name ¥ | Incident Start | Incident End | Duration | Exir ¥ | Progress T | Purger ¥ | Completi

v

7608  28/02/2023 9:02:28 AM [#5) GTDVR Impact Alarm 28/02/2023 8: 28/02/2023 8 00:00:30 o 28/02/2( System/RS Mabile
7607  28/02/2023 9:00:20 AM =5 GTDVR Hard brake 28/02/20238: 28/02/2023 & 00:00:30 28/02/2( Auto System/RS Mobile
7606  28/02/2023 8:58:18 AM 9 GTDVR  Tag Alarm 28/02/2023 8: 28/02/2023 8 00:00:30 o 28/02/2( Auto System/RS Mabile
7605  28/02/2023 8:56:15 AM (=5 GTDVR Operator Alarm  28/02/20238: 28/02/2023 € 00:00:30 28/02/20 Auto System/RS Mobile
7604  28/02/2023 8:54:00 AM = GTDVR Hard brake 28/02/20238: 28/02/2023 8 00:00:30 28/02/2( Auto System/RS Mobile
7603  28/02/2023 8:50:30 AM [#5) GTDVR Impact Alarm 28/02/2023 8: 28/02/2023 8 00:00:30 o 28/02/2( Auto System/RS Mabile

28/02/2023 8:48:29 AM Operator Alarm  28/02/2023 8: 28/02/2023 € 00:00:30 o 28/02/2( System/RS Mobile

2 Click the My Incidents [i] button.

The list refreshes to show only incidents with your (currently logged in) user name. The user
name matches the user name shown at the top right of the Command Client interface.

1053104132 — O X

Liser A

The My Incidents button is displayed in blue when active.

r*:’ 4.! .I 10.53.104.132

User A
e Indident Archive X 4 -

QLR Past 7 Days L =Tl 1

ID ¥  Incdent Created | Usemame T | Ve T | Inddent Name ¥ | Incident Start | Incident End | Duration Exir ¥ |Progress ¥ | Pu¥  Complet Type ¥ | Path

AN 1003 |
7608  28/02/2018 9:02 User A = GTDVR Operator Alarm  28/02/2018 8! 28/02/2018 8 00:00:30 28/02/20 Auto System/RS Mabile
7607 | 28/02/2018 9:00 User A = GTDVR Hard brake 28(02/2018 B: 28/02/2018 8 00:00:30 28/02/20 Auto System/RS Mabile

3 4 5 6 7 8 9 10 » »
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Searching for an Archived Incident

The Incident Archive list can potentially hold thousands of incidents, so if you have multiple pages
of incidents, you can use the search functionality to find a specific incident or group of incidents.

You can also sort and filter the columns in the list to help find an incident.

To search the Incident Archive list
1 Open the Incident Archive tab to view the list of incidents.

S Incident Archive X -

Time Period: [ « M | BE | rglis}

ID T | Incident Created Usemame ¥  Vehice ID ¥ | Incident Name ¥ Incident Start | Incident End | Duration | Exir ¥ Progress T |Purger ¥ | Completi Type T

v

7608  28/02/2023 9:02:28 AM [#5) GTDVR Impact Alarm 28/02/2023 8: 28/02/2023 8 00:00:30 o 28/02/2( System/RS Mabile
7607  28/02/2023 9:00:20 AM =5 GTDVR Hard brake 28/02/20238: 28/02/2023 & 00:00:30 28/02/2( Auto System/RS Mobile
7606  28/02/2023 8:58:18 AM 9 GTDVR  Tag Alarm 28/02/2023 8: 28/02/2023 8 00:00:30 o 28/02/2( Auto System/RS Mabile
7605  28/02/2023 8:56:15 AM (=5 GTDVR Operator Alarm  28/02/20238: 28/02/2023 € 00:00:30 28/02/20 Auto System/RS Mobile
7604  28/02/2023 8:54:00 AM = GTDVR Hard brake 28/02/20238: 28/02/2023 8 00:00:30 28/02/2( Auto System/RS Mobile
7603  28/02/2023 8:50:30 AM [#5) GTDVR Impact Alarm 28/02/2023 8: 28/02/2023 8 00:00:30 o 28/02/2( Auto System/RS Mabile

28/02/2023 8:48:29 AM Operator Alarm  28/02/2023 8: 28/02/2023 € 00:00:30 o 28/02/2( System/RS Mobile

1 2 3 4 5 6 7 8 9 10 ¢ »

2 Click the calendar icon in the Time Period box to choose a preselected time period, or choose

Select Range to open a calendar and set you own time period.

RN = A Past 7 Days

ID” ¥ | Incident Create | Usernam{BNEN
Yesterday
8450 3/6/2018 8:34:
Past 14 Days
Past 30 Days
Select Date
Select Range

B451  3/B6/2018 B:35:

3 Click search .
The results of the search appear.

If the search results are on multiple pages, you can use the page numbers at the bottom of the

tab to navigate to the other pages.

1 2 F »

To sort the Incident Archive list
You can alphabetically or numerically sort a column list (depending on the content of the list).
1 To sortin a column, click on a column header to show the Sort n icon.

2 Click the Sort icon to automatically sort the elements in the column list in ascending or
descending alphabetical or numerical order.

Note: Click on the Sort icon again to change the order from ascending to descending or from

descending to ascending.
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To filter the Incident Archive list
You can filter device data in a column list to show only specified list values.

1 Tofilter a column, select a column header and click the Filter icon. (Not all columns offer
the filter icon.)

VehidelD

The Filter dialog box appears. The filtering options depend upon the content of the column, for
example, some columns offer check boxes, some offer a text box with a list.
Inddent Name

Show rows with value that
Starts with

Waiting for recorder connection
Pausad
Downloading

N

i Clear Fiter

Download successful
Download successful: Missing dat
Download failed: No data found
Download failed: Timeout contad|
Download failed: Disk problem or|
Download failed: Unknown problg

Clear Flter

2 Tofilter using the check boxes (if available), click one or more check boxes or click Select all to
select all column elements.

As you select a check box, the column automatically refreshes with the selected criteria.

3 To configure a text filter, click the Show rows with value that drop-down list and select a filter
expression.

4 If applicable, enter a filter criteria in the text box.
5 Click Filter.
The column list displays only those device details that match the specified filter criteria.

Note: Toremove all existing filters from a selected list column, open the Filter dialog box and click
Clear Filter, or click the Remove Filter m button on the tab toolbar.
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Playing an Incident

After automatic and scheduled incidents have been extracted from the mobile recorder, you

Using the Incident Archive

can use Command Client to play the video from these incidents.

To play an incident from the Incident Archive

1 Open the Incident Archive tab to view the list of incidents.

S Inddent Archive “|ar|®

RUIESN N past 7 Days o OE R e

ID T | Inddent Created Usemame T | Vehicle ID

26/02/2023 9:02:28 AM
26/02/2023 9:00:20 AM
26/02/2023 8:58:18 AM
26/02/2023 8:56:15 AM
26/02/2023 8:54:00 AM
26/02/2023 8:50:30 AM
28/02/2023 8:48:29 AM
1 23 456 7 8 910 » W

Impact Alarm
Hard brake
Tag Alarm
Operator Alarm
Hard brake
Impact Alarm
Operator Alarm

&-E]

¥ | InddentName ¥ | Incident Start

26/02/2023 8:
26/02/2023 8:
26/02/2023 8:
26/02/2023 8:
26/02/2023 8:
26/02/2023 8:
28/02/2023 8:

o]

Incident End

26/02/2023 €
26/02/2023 €
28/02/2023 €
28/02/2023 €
28/02/2023 €
26/02/2023 €
28/02/2023 &

Duration

00:00:30
00:00:30
00:00:30
00:00:30
00:00:30
00:00:30
00:00:30

Extr ¥ |Progress T |Purger T Completi| Type T

28/02/2( Auto
28/02/2( Auto
28/02/2( Auto
28/02/2( Auto
28/02/20 Auto
26/02/2( Auto
28/02/2( Auto

2 Select the incident that you want to view and click the Play Incident

click the incident).

Note: You can only view an incident after it has finished downloading.

The incident opens in a new tab.

By default, the associated video is paused when you open the incident. If there are multiple
cameras associated with the incident, they open in synchronized mode. If there is GPS

Path

System/R5 Mobile
System/R5 Mobile
System/R5 Mobile
System/R5 Mobile
System/R5 Mobile
System/RS Mobile
System/R5 Mobile

button (or double-

information available for the incident, the GPS map panel is available to the right and the route
of the vehicle is displayed on the map. An arrow indicates the vehicle’s position on the route

(click Play if you do not see the arrow immediately.)
Note: The GPS map can be configured to open automatically or not (see “Preferences for

Transportation Features” on page 33).

S Inddent Archive X 23 Inadent from_Device HA GI* =+ ~

When you open the incident, you can:

* View the video from the camera or cameras you included in the incident extraction

Monday, November 8

*  View the GPS map, which includes the vehicle’s route, speed, and position
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* Click on the route in the GPS map to see the camera view from that time and place

* Click on the timeline to see the position on the GPS map and the camera view from that
time (timeline is restricted to duration of the incident)

* Play and pause the video from the camera and the position of the vehicle on the GPS map

3 Click the Play n button to play the video and show the position of the vehicle on the route
map. The arrow on the route map moves to show the progress of the vehicle.

E# Incident Archive * B8 Inddent_from_Device HA GI® 4 -~

T o )

Williamsvifle

Camera 3
HA_GPS

Monday, November &

4 If you want to review the video from a camera not initially included in the incident, you can
adjust the grid size to add an empty cell, then drag and drop a camera from the Navigation
panel to the incident. Once the camera is added to the incident, you are able to view associated
data from that camera (restricted to the time duration of the incident).

Note: You cannot save the added camera(s) to the incident - if you close the incident and
open it again, only the camera(s) originally included in the incident are present.

NAVIGATION  EVIDENCE T E* Incdent Archive * &% Sample Incident

IP Camera 5
4 | HA GPS

™ Camera 6
= Camera 7
I = camena

=« TP Camera 1

 Logical
B3 Logical

Monday, February 22 - Monday, February 22

2:06 PM 2 210
T o e o0 e e T

3 Personal

(B Fl & 11 [
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Incident Archive Tab: Recorder or Media Archiver Removed

If the list in the Incident Archive tab contains incidents from a recorder or Media Archiver that has
been removed from the Command interface (for example, by deleting the device from the
Navigation tree), the incidents appear in dimmed text, as the recorder or Media Archiver they are
associated to is no longer available.

You cannot view these incidents, but you can delete them from the archiver list (provided you have
the Delete / Pause Incidents user right).

Deleted Media Archiver - Restore Incidents

If you delete a Media Archiver you can restore the incidents by adding the same Media Archiver
back to Command (see “Adding the Command Media Archiver to Command” on page 20). When
the Media Archiver is successfully re-registered to Command, the incidents associated with that
archiver become available again in the Incident Archive tab.

Deleted Recorder - CANNOT Restore Incidents

Warning: If you remove a recorder, you cannot restore the incidents associated with that recorder
by re-adding the missing device. The incidents remain in the list for historical purposes, but cannot
be made available again by re-adding the missing device. In order to view the information from that
incident again, you must re-add the device and create a new incident with the same parameters
(recorder, start and end date/time).

=+ Inddent Archive SR
Time Porioc: - £ Bo-
ID ¥ Inddent Created ¥ Usemame ¥ Vehicle ID Inddent Name ¥ | Inddent Start T | Inddent End ¥ | Duration ¥ | Exir. Status | Progress
1 13/02/2015 10:00:00 TechPub (B HAGPS Incident_from_Device_HAGPS_ 13/02/2015 10:00:00 AM 13/02/2015 10:10:00 AM  00:10:00 V4 13/02/20 Sdl
2 13/02/2015 4:00:00  TechPub Missing Device: CES Resource ID: (150) Incident_from_Device HADVR_ 13/02/2015 4:00:00 PM (UTC) 13/02/2015 4:04:00 PM (1 00:04:00 13/02/20 Sd
3 17/02/2015 3:50:00  TechPub [#5) HAGPS Incident_from_Device_HAGPS_  17/02/2015 3:50:00 PM 17/02/20154:00:40 PM  00:10:49 v 17/02/20 Sdl
4 18/02/2015 9:18:00  TechPub (@5 HAGPS Incident_from_Device HAGPS_ 18/02/2015 9:18:00 AM 18/02/2015 9:32:30 AM  00:14:30 v 18/02/20 Sdl
5 18/02/2015 10:30:00 TechPub (B HAGPS Incident_from_Device_HAGPS_  18/02/2015 10:30:00 AM 18/02/2015 10:46:00 AM  00:16:00 HH [ % | Sd
‘

Using the GPS Map

The GPS map can appear in an incident tab, in a camera / view tab, or in an alarm view tab (GPS data
must be supported by the recorder that the incident / camera / alarm video was extracted from).

For more information on working with camera/view tabs and alarm views, see the Command
Enterprise and Client User Guide, available from the March Networks Partner Portal website, or
from the Help menu item in Command Enterprise.

The GPS map works slightly differently when viewing an incident tab, or viewing a live
camera/view tab.

Note: GPS maps are also available in the Command Client interface when you are connected to a
single RideSafe recorder, in a camera / view tab, or in an alarm view tab. Incident tabs are only
available when the Comment Client is connected to Command Enterprise.

Using the GPS map in an Incident Tab

The Command Enterprise Incident tab is archive video only, from the time of the incident. You
cannot view live video in an incident tab.The visual finder (a bar below the timeline that shows the
current time period) is not available. You cannot view video from before the start of the incident or
after the end of the incident - available video is limited to the duration of the incident.
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To use the GPS map in an Incident tab
1 Inthe Incident Archive tab, double-click on the incident that you want to view video from.
The Incident opens in a new tab.

Ee Incident Archive % B8 Tncdent from Device March® = - =
MR ) ey
1P Camera | 11:15:07 AM o TP Camera 5 1L15:07 AM o 158 ‘ o
4 ardREOVR P e X s B = X | S - i 25/01/2021 11:15:07 AM
@
@

Monday, Jaﬁw = Manday, January 25

15 11135
0 f

noe e GEARGE

The visual finder bar (below timeline) is not available in the incident tab and the timeline
displays only the duration of the incident (from start date/time to end date/time). You cannot
scroll on the timeline before or after the incident.

2 If there are multiple cameras included in the incident, click the camera that you want to view
video from.

Note: When you open the incident, if there are multiple cameras in a view, they are
automatically synchronized. You can click the Synchronize Grid E button to un-synchronize
or re-synchronize the video from the cameras in the grid.

The GPS map shows the route of the vehicle for the time of that incident.
3 On the GPS map, move the mouse pointer over the vehicle route.

The mouse pointer changes to indicate when you can click on the route for video from
that point.

Emﬂnﬁuenm @

4 Click on the route at the point where you want to see video.

=

SN Aver

Jeffe

ace

If multiple cameras are synchronized, all the video streams switch to show the picture from the
new point on the GPS map. If multiple cameras are not synchronized or there is only one
camera included in the incident, the selected single camera switches to show the picture from
the new point on the GPS map.

Note: It is possible that not all points in the route have available GPS data - for example, if the
vehicle goes into a tunnel where satellite information is unavailable, that part of the route does
not have GPS data. (The route on the map shows the line drawn from the last known GPS point
to the point where the GPS data is available again.)
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Using the GPS map in a Camera Tab or View Tab

The camera or view tab can show live or archive video - you can switch from one to the other. The
visual finder (a bar below the timeline that shows the current time period) is available and you can
change the time scale. You can scroll on the timeline to view different dates and times. For more
information on camera and view tabs, see the Command Enterprise and Client User Guide, available
from the March Networks Partner Portal website, or from the Help menu item in Command
Enterprise.

Note: Camera or view tabs with GPS are also available in the Command Client interface when you
are connected to a single RideSafe recorder.

To use the GPS map in a Camera tab or View tab

1

Command 2.17 Transportation User Guide

Open a single camera tab or a view tab with video from a device that supports GPS data.

The tab opens with the GPS map (the map can open automatically or not, depending on your
preferences, see “Preferences for Transportation Features” on page 33).

=4 [P Camera 2 e "N =

System ~ MohamedDVR ~ MarchRSDVR  IP Camera 2 = L =2 T el )

IP Camera 2 734302 AM . 198 4.
Ll Sajiaoas 4. iim MarchRSDVR 24/02/20217:34:31 AM
1L 1

I BIUINEE) -

vair. D

% s
NI
“NassauRd ARG
: i
o

% 2
%@,q \ %Q%hg#ulaneﬁd. ! =

Wake ForestRd—
o

Wednesday, February 24

f} = B = ‘ . |

Cl:)\ - Fetinary-23-21
- oM 10PM | 11PM | 13AM 1AM | JAM 3AM | 4AM SAM | GAM 7 9AM | 1DAM 11AM | 12PM 1M | 3P 39M | dpM | M

i BB & B ] & 11 [ &

The visual finder bar (below timeline) is available in the camera or view tab. You can alter the
timeline scale. You can scroll on the timeline to view different dates and times.

When you open a live video stream from a RideSafe series recorder, the GPS map shows the
route of the vehicle for the last hour (assuming GPS data was available). When you go into
archive playback mode, you see one hour before and one hour after the requested time

position.

If you are working with a view, click on the camera that you want to view video from. You can
click the Synchronize Grid E button to synchronize or un-synchronize the video from the
cameras in the grid.
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3 On the GPS map, move the mouse pointer over the vehicle route.

The mouse pointer changes to indicate when you can click on the route for video from
that point.

Meec

Hedley Place

Emﬂlmvenm qr_n)

Jeffersin Avenus

lace

4 Click on the route at the point where you want to see video.

If multiple cameras are synchronized, all the video streams switch to show the picture from the
new point on the GPS map. If multiple cameras are not synchronized or there is only one
camera, the selected single camera switches to show the picture from the new point on the
GPS map.

Note: It is possible that not all points in the route have available GPS data - for example, if the
vehicle goes into a tunnel where satellite information is unavailable, that part of the route does
not have GPS data. (The route on the map shows the line drawn from the last known GPS point
to the point where the GPS data is available again.)

Viewing Text Overlay

You can use the Command Client’s text overlay feature to display associated text in a media cell,
over the picture that the camera displays. To display text in a media cell, the camera displaying the
video must be linked to a device that is streaming text.

Note: For more information about linking text to a camera, see the Administrator Console User
Manual.

If you have the access rights to view live and archive video, you can view associated text.

The text overlay is configurable to best suit your needs. You can change the size and placement of
the text area, the font size, and how long the text stays in the media cell.

IP Cam Mobile 10:21:24 AM
R > 1isfz0z1 = ¥

* Bus ID: 123456
Operator ID: 567859
Route Variatiom: 12:11
Odometer (feet) : 634567
Current Stop: ES 1255T

Current Trip ID: 4234
Current Block ID: 5678

Current Speed(feet/second) :
overt Alarm State: 1 ]
Covert Alarm State: 0

Note: By default, if text overlay is available, it appears. You can choose to hide it.
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To show or hide text overlay

1 In a media cell with text overlay visible, right-click to display the shortcut menu.
F] Openin New Tab
Take Snapshot
Shiow Text Area

(9 InstantReplay »

When the text overlay is set to show, the Show Text Area icon is selected.
2 Click Show Text Area to clear the selection of the text icon and hide the text.
The menu closes and the text overlay is hidden.
Note: To show the text again, right-click to display the shortcut menu. The Show Text Area
icon is not selected.

T show Text Area '

Click Show Text Area to show the text overlay again.

Configuring Text Overlay
You can configure the way the text overlay is displayed on the media cell to best suit your needs.

You can change the size of the text area, change the position of the text area on the media cell,
change the font size, dictate how long the text displays on the media cell, and apply the settings
from one media cell to the entire grid.

To configure the display of text overlay

1 Inaview tab or a single camera channel tab with text overlay available, click the Text Area
Settings button (on the tab toolbar above the media cell or cells).

The Text Area indicator appears on the media cell.

Camera 2 p 2:38:05PM
GTDVR 11/8/2021 **

ol
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2 Toresize the text area:

* Move your mouse over one of the corners of the text area square until the cursor changes
to an arrow.

* Click and drag the text area rectangle until it is the size that you want.

Camera 2 2:38:05 PM -
[ 11/gj2021 ™

3 To move the text area on the media cell:
* Move your mouse over the text area square until the cursor changes to a hand.

2:38:05 PM -
< 1182021 " i

n
Text Area
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4 You can alter the size of the font:
* Inthe upper right corner of the text area rectangle, click the Text Overlay Options

E button.

The Text Overlay Options menu appears.

Camera 2 2:38:05 PM
™ DR 11/8/2021

:'Text.l\ru
Font Size:
O Auto
® Smallest
__ @ Smaller
= @ Normal
@ larger
@ largest
Display Time:
® Keep Until Next
O Keep for (s) 5

——

RN G

* Under Font Size, select the size that suits your needs.
The Text Area font in the upper left of the rectangle changes to show you the new size.
5 You can alter the amount of time the text overlay stays on the media cell:
+  Click the Text Overlay Options [-§ button.
The Text Overlay Options menu appears.
* Under Display Time, select either:

Keep Until Next — This option displays the current text overlay until a new text overlay
replaces it.

Keep for (s) — This option displays the current text overlay for the amount of time you
enter into the box provided (in seconds). If there is no new text after the time period
expires, no text overlay is shown in the media cell.

6 You can apply the settings from one media cell to the entire grid. This includes the size of the
text area, its position, the font size, and the display time.

+  Click the Text Overlay Options [5§ button.
The Text Overlay Options menu appears.

* Click the Apply to Grid button. (This button is only present if you are viewing a camera
grid. The button does not appear when viewing a single camera.)

A dialog box appears, asking if you want to apply the settings to the whole grid.
* Click Yes.

7 To close the Text Area indicator and view your new settings, click the Text Area Settings
button again.

After you make changes to the Text Overlay settings in a view tab, you must save the view to save
the Text Overlay settings.
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Exporting an Incident

In the Command Client connected to Enterprise, you can export the video, audio, and GPS data
from an incident to a case file or directly to file.

To export incident data to a case or file

1 IntheIncident Archive tab, select the incident that you want to export video from and click the
Play Incident button (or double-click the incident).

The Incident opens in a new tab.

= Inddent Archive * 2B Inddent from_Device March™ == - -
] - - & o
LSS I Ll o )
1P Camera 1 11:15:07 AM g 1P Camera 5 11:15:07 AM o ; e
o A > X e > - X  25/01/2021 11:15:07 AM

2540112021 25/01/2021
2
- Edinger Ave é\'\.

Valley

Monday, January 25

Monday, Janlry 25
A‘F 11135
f

15
'

© M nos e A G B F & 1w O %

2 On the Timeline toolbar, click the Export Video & button.
The Export dialog box appears.
3 Select from:

* Export as View
If you are exporting from a view tab, you can select to export the video as a view file,
including all the cameras that are included in the view. If you are exporting from a single
camera tab, the Export as View option is not available.

By default, the file name for an incident uses the following format: Incident Name-Clip Start
Date.Time-Clip End Date.Time. You can click in the File Name box to type a new name.

E} Export

O Export as View
File Name:

Sample Incident-20150203.113100-20150203.113600

@ Export as Separate Video Channels

Name File name

Start: End: Interval:
03/02/2015 [BJ11:31:00 AM 03/02/2015 [B1f11:36:00 AM 00:05:00

Next Cancel

Command 2.17 Transportation User Guide 70



Using the Incident Archive

* Export as Separate Video Channels

If you are exporting from a view tab, all the cameras in the view appear in the list, and you
can select the ones you want to export video from. If you are exporting from a single tab,
only one camera appears in the list.

Select the camera or cameras you want to export video from.

By default, the file name for a single camera uses the following format: Camera Name-
Recorder Name-Clip Start Date.Time-Clip End Date.Time. You can click in the File
Name row in the table to type a new name.
Note: If the selected timeline occurs during the Daylight Saving Time shift, a DST check
box appears on the Export dialog box. When selected, the DST period is included in the export.

4 Modify the Start and End time, as required.

Interval:

Start: End:
19/01/2015 I'EI 1:12:09 PM 19/01/2015 EI 2:12:09 PM 01:00:00

This is the start and end time of the video you are exporting.

Note: When you are exporting from an Incident tab, the start and end time must be within the
time period of the incident. You cannot export video or associated data that is not included in
the incident.

When you export from multiple cameras, all the videos have the same start and end time. The
Interval field shows the length of the video with the selected start and end times.

5 Click Next.
The second page of the Export window appears.

£ EBxqort
Visualization Mode:
Current

[l Add Text Data to Exported Media
Il Add Watermark to Exported Media

Destination:

Local

C:\Users\clockie\Videos Browse
Format:

CME (Native) -

Form factor: Bitrate (Kb/s): Resolution:

Auto Auto De

Map Source:

Split File:

Il Indude Command Player

Export Cancel
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6 Modify the values as described in the following table. For more information, see the Command
Enterprise and Client User Guide, available from the March Networks Partner Portal website, or
from the Help menu item in Command Enterprise.

Export Value

Description

Visualization
Mode

Select from:

+ Default: If you set up a default level of zoom for the video channel, the video you
export reflects that, regardless of the current zoom level in the media cell. If no
default zoom level is set, this is the same as the original view.

+  Current: Retains the current zoom level and/or dewarping of the video channel in
the tab or view. If the zoom level currently displayed in the workspace is 1.5x (for
example), the video you export is also at zoom level 1.5x. If you have dewarped
the video in the workspace (from a camera with an applicable lens), the video you
export is also dewarped.

* Original: This exports video with the full original image from the video channel,
without any zoom and/or dewarping, regardless of what is currently set in the
media cell.

Add text
data...

If you want to include text overlay with the exported video (if available), select the
Add text data to exported media check box.

Add

Watermark...

Note: This check box only appears if your user profile has the Watermark General
Right set to Optional. Not available if you select the Case destination (you can add a
watermark to a case file when you export the case.)

If you want to apply a Watermark over the exported video, select the Add Watermark
to Exported Media check box.

The appearance of the watermark is configured on the Command Enterprise Software
server. You cannot modify it in Command Client.

Destination

In the Destination section, select from:

* Local — The file path to the folder where you want to save your video (for
example, C:\Users\<username>\Videos).

Click the Browse button to select a different folder. You can browse to a local
folder on the computer or a removable drive, for example, a USB stick. (You
cannot export to removable media on a Mac OS X platform.)

Note: To save to a CD or a DVD, select CD/DVD drive (described below). This
allows Command to manage the CD/DVD burning procedure. Browsing to the CD
or DVD drive is not recommended.

+ CD/DVD drive — If you have any available read/write CD and/or DVD drives, this
enables a drop-down list of the drives. You can burn to a CD or DVD if you select
an available RW Drive or connected burner. For the CD/DVD burning procedure,
see the Command Enterprise and Client User Guide.

+ Case — Save the video to a case file. For more information on Case files, see the
Command Enterprise and Client User Guide.

Note: The External Media Device option is not supported when exporting from an

incident in the Incident Archive.




Export Value

Description

Format

Note: Not available if you select the Case destination.
From the Format list, select a file format for your exported video.

*+  CME (Native): Command Multimedia Evidence. This is a March Networks
proprietary video file format which can only be played using the Command Player.
The fact that this file format can only be viewed using the Command Player
ensures that sensitive video evidence cannot be easily shared over the Internet or
posted for public view.

*  CME (Encrypted): Command Multimedia Evidence. This the same as the CME
Native format, but it is in an encrypted format, so that a password is required to
play the video.

If you select this option, you must specify a password that the end user must enter
to play the video after it is exported.

+ MP4 (H264/AAC): This is a universal format which can be played anywhere, but it
is slower to export (the media is transcoded to H264/AAC, then copied to an MP4
container). Only available for single camera, video-only exports.

Important: If you select the MP4 format, the GPS map data is not included in the
exported file, only the video from the incident.

Form Factor

Note: Only available if you select the MP4 (H264/AAC) format.
From the Form Factor list, select the form for the video.

* The Auto option retains the aspect ratio and resolution of the original video
channel. The Resolution field is set to Auto Detect and cannot be edited.

* The Landscape option allows you to alter the Resolution field. A Resolution drop-
down list appears with a list of aspect ratios in landscape format.

* The Portrait option allows you to alter the Resolution field. A Resolution drop-
down list appears with a list of aspect ratios in portrait format.

Bitrate

Note: Only available if you select the MP4 (H264/AAC) format.

From the Bitrate (Kb/s) list, select a bitrate for the video. This determines the size and
quality of the video. A video with a higher bitrate (for example, 2048 Kb/s) is better
quality than a lower bitrate video (for example, 256 Kb/s) but the higher bitrate video
will be a much larger file.

The bitrate is a target that assumes a frame rate of 30 ips (images per second). If the
video was recorded at a lower frame rate, the bitrate of the exported video will also be
lower.

In extreme cases, when the bitrate you request is either much greater or much less
than the bitrate of the video when it was recorded, the exported video may not be able
to reach the target you set. For example, if the bitrate target you set is very high (8192
Kb/s), but the bitrate when the video was recorded was very low (64 Kb/s), there is
not enough data in the recorded video for the system to produce exported video of
the bitrate you requested. The video will be exported at the maximum bitrate that the
system is able to produce under the circumstances.

Resolution

Note: Only available if you select the MP4 (H264/AAC) format and you do not select
Auto from the Form Factor list.

If you have selected the Landscape or Portrait option from the Form Factor list, select
a Resolution from the list.

Note: You must select a resolution in the same format (for example, 16x9 or 3x4) as
the original camera to prevent the video from being stretched.




Export Value

Description

Downscale
video...

Note: Only available if you select the MP4 (H264/AAC) format.

(Optional) Select the Downscale video with resolution higher than full HD check
box to automatically downscale the video resolution to a resolution equal to or lower
than full HD, depending on the aspect ratio. This is useful to view the exported video
on media players that are not able to play multi-megapixel videos.

Map Source

Note: Only available with CME format and if your Export Map Policy is configured to
allow both default and custom maps. For more information on setting the Export Map
Policy, see the Command Enterprise Installation Guide.

Choose which GPS map you want to include with your exported video when the CME
file is opened in the Command Player:

* Default Only - Only the default GPS map is displayed.

¢ Custom Only - Only the custom GPS map is displayed.

* Default and Custom - An additional button appears in the Command Player,

allowing the user to toggle between the default or custom GPS maps. See “GPS
Controls in the Command Player” on page 99.

Password

Note: Only available if you select the CME (Encrypted) file format.

If you selected the CME (Encrypted) file format, you must enter (and re-enter) a
password for the exported video file. The exported video remains encrypted and the
end user cannot view the video file until they enter the password that you specify here.

Note: Click the eye ##®}F icon to display the characters of the password in the dialog
instead of the password masking dots.

Split File

Note: Not available if you select the Case destination or if you select Export as View
on the first page.

The Split File list allows you to break up a large video file into smaller files so that you
can export to a CD-ROM or a DVD, or any external media with limited space. To use
this feature, select the external media that you want to export to (for example, DVD
DL 8.5 GB). When you click Export, the file is divided into multiple files that fit onto the
media you selected. If you select Custom from the list, a size box appears and you can
select a custom size in MB.

Include
Command
Player

Note: Not available if you select the Case destination.

If you want to include the executable file for the portable Command Player with the
exported video file, select this check box. Command Player is a playback tool that
allows others to view video in the proprietary CME format (including case files).

7 Click Export.

If the Destination you selected was a local folder on the computer or CD/DVD drive:
The video is saved in the file format you selected: CME or MP4.

The file is displayed in the Export panel in the Dashboard. The Status column shows
the progress. If you are exporting video from multiple cameras, the progress of
each file is shown.

HEALTH (5

ALARMS ()

# | Filename ¥ | Source Stream ¥ | Interval Status

n 3 PTZCamera-TRCRSSVR 2 = PTZ Camera 25/06/2013 1:15:00 M 25/09/2013 1:20:00 PM  00:05:00
m 2 PTZ CameraTPCRSSVR 2. /™ PTZ Camera 25/00/2012 1:10:00 PM  25/00/2013 1:11:00 PM  00:01:00  / Export Successful

2 items (0 items filtered)
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Tip: If you want to stop the export while it is still in progress, you can click the Cancel
Video Export button. The file in progress is deleted. Click the Restart Video Export
button that appears in the row to begin the export again.

HEALTH s ALARMS (m

# | Filename ¥ | Source Stream T | Start T | Interval Status

3 Sample.mp4 =4 Camera 1 07/10/2014 7:35:55 AM 07/10/2014 7:55:55 AM 00:20:00 . Cancelled by User

1 items (0 items filtered)

After the video clip is successfully exported, you can click the Close Export Video m
button to remove the entry from the Dashboard.

Note: Entries in the Export panel are cleared when you log out of Command Client.
* |f the Destination you selected was a Case file:

The Case Management tab opens, with the new video file added to the list of
evidence files.

= Camera 1 * B case20180622.143815 ¥ * 4+ -

oc L0 UET LU Case 20180622.143815 [ ] _ %"

¥
X Iy

T 3. Note

Camera 1
L 33/06/2018 1:37:32 PM - 22/06/2018 10:33:26 AM

9B camera 1 Case Note

-

When a video file from an incident is added to a case, the video is saved on the Archiver.
This ensures that the video is available to the case file even if the original incident is not
available.

When a video file in a case is saved to the Archiver, a symbol appears on the video icon, to
indicate the status of the save to the Archiver, as described in the following table.

Important: After exporting video to the case, you must save, close, and re-open the case
tab to view the symbols on the video icon. The symbols do not appear until the case tab is
re-opened from the Evidence panel.

Note: Tooltip text also appears when you move your mouse over the black part of the
video icon.

IP Camerz 2
2021-06-08 7:37:00 AM - 2021

Success '

Icon Description

Success
The video file including all data is successfully saved to the Archiver.

Success, missing some data

The video file is saved to the Archiver, but there is some data missing, for example,
the video is saved but the audio information is missing, or there are gaps in the video.

B
=
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Icon Description

Failed, Failed (local storage), or Failed (timeout)
The video file is not saved to the Archiver, the save has failed.

If the tool tip indicates local storage, the operation to save the video to the Archiver
failed because the storage on the archiver is full. See “Ensuring the Archiver has
Enough Space” on page 84.

If the tool tip indicates timeout, the operation to save the video to the Archiver timed
out before it could be completed.

No data available
EL The video file is saved to the Archiver, but there is no data.

No Archiver available

E The video file is saved to the case, but not to an Archiver.

If you are saving to a case when connected to a single recorder (in which case an
Archiver is not used), the video file icon does not show any additional symbols.

In this situation, when playing back the video added to the case, the system retrieves
the video file from the recorder instead of an Archiver.

For more information about the Case Management tab, see the Command Enterprise
and Client User Guide.

Automatic Incident Creation

Depending on how your system is configured, when a physical alarm (such as a physical button
that the vehicle driver presses) is triggered, the system automatically downloads video and data
related to that alarm.

When this occurs, the incident appears in the Incident Archive tab and you can investigate the
available evidence by viewing the incident.

The duration of the video and data downloaded depends on how your system is configured.
Typically the incident provides a certain amount of video and data from before and after the time
the alarm is triggered. For example, if the relevant alarm is triggered at 5:00 pm, the incident
provides video and data from 4:58 pm to 5:03 pm (2 minutes duration before the alarm and 3
minutes duration after the alarm).

Configuring Automatic Incidents

Use the Administrator Console to configure automatic incident extraction per recorder. You can
configure the duration of the incident data by setting how much data is saved before and after the
incident is triggered. You do this by setting up a Tag Data Action on the recorder from which you
want to extract incident data.

Note: You can set up the incident extraction for the Tag Data Action as automatic or not. See the
Administrator Console User Manual (Mobile Recorders) for details on configuring actions.
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Viewing Automatic Incidents

When a relevant alarm is triggered, the incident is automatically extracted and appears in the
Incident Archive tab with the name of the alarm that triggered it, for example Tag Alarm.

The Type column shows Automatic for an automatic incident.

You can see the alarm that triggered the incident in the Alarms panel: the name is the same as the
incident (for example Tag Alarm) and the Alarm Type is Physical Input.

= 3. >
T h e LR
3 E#* Inddent Archive I

QUGS past 7 Days 5] ~ lC: e

EVIDENCE T
=
¥, ID ¥ Inddent Created Usemame T | Vehide ¥ InddentName ¥ |IncidentStart | IncidentEnd | Duration |Exir ¥ | Progress ¥ Purger ¥ Completi| Type ¥ | Path
-
1

== PV_87045_09 28/02/2018 9:02:28 AM Operator Alzrm 28/02/2018 8: 28/02/2018 8 00:00:30 28/02/2( Auto System/RS Mobile

»— = PV_Atom_NoMezz_07 - 28/02/2018 9:00:20 AM Hard brake 28/02/2018 8: 28/02f2018 8 00:00:30 28/02/2( Auto Systam/RS Mobils

Y Logical » 28/02/2018 8:58:18 AM Tag Alarm 28/02/2018 8: 28/02/2018 8 00:00:30 28/02/2( Auto System/RS Mobile
4 Personal 3 12 3 456 7 89

HEALTH @z ALARMS {11y EXPORT
T | Name ¥ | Device ¥ | IP/Hostmame ¥ | Handled By ¥ | First Occurrence ¥ | Last Occurrence ¥ | Alarm Count ¥ | Alarm Type
“ () Tag Alarm 10.51.64.85 Not Handled 20/02/2015 3:40:39 PM  24/02/2015 11:35:26 AM 2 Physical Input
1 items (0 items filtered)

Incident in the Incident Archive tab:
S Incident Archive NEHE

1o veoc: ] B Mo

1D T  Inddent Created Usemame ¥ | Vehide ID T | Inddent Name ¥  Incident Start | Incident End Duration Bxtr T Progress ¥ |Purger T | Complet | Type T | Path

7609 28/02/2018 9:03:37 AM = GTDVR Tag Alarm 28/02/2018 8: 28/02/2018 8 00:00:30 28/02/21 Auto System/R5 Mobile

Physical alarm in the Alarms Panel:

HEALTH @z ALARMS (113 EXPORT

T | Name T | Device T IPfHostname T  Handled By T | First Occurrence ¥ | Last Ocaurrence ¥ | Alarm Count ¥ | Alarm Type ¥

'Y + (@) TagAlarm GTDWR 10.51.54.85 Mot Handled  20/02/2015 3:40:30 PM  24/02/2015 11:35:26 AM 2 Physical Input
¥ - =
1 itemns (0 items filtered)

Tip: The Extraction Status column displays icons that help you track the progress of your
incident download. Hover your mouse over the icon to see additional information about the
status. For more information, see “Troubleshooting an Incident Extraction” on page 54.

Incident End Duration | Extraction Status ¥ | Progress ¥  Purged T

03/05/2019 2:09:10 PM  00:00:30 W
[ Download successfu[ﬁ
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Navigating Multiple Pages and Blocks of Incidents

The Incident Archive list can potentially hold thousands of incidents, so the incident list may have
multiple pages of incidents. By default each page in the list displays 30 incidents. The incidents are
also divided into blocks, which is a group of 10 pages (each block has a default of 300 incidents).

You can use the controls at the bottom of the list to move between pages, and if there are enough
incidents, to move between blocks.

1 2 3 4 5 6 7 8 9 10 ¢ w»

) (N

Click to go to Click to go to next Click to go to next
page 3 of incidents page of incidents block of incidents

Refreshing the Incident List

When you or another user create a new incident, the incident is not displayed in the list
immediately. Instead, the Refresh button becomes available, and the new incident count beside it
increases.

e

s 10 10 new incidents are available.

After you click Refresh and the new incidents are retrieved, the background for the new
incident row is a pale yellow.

=% Inddent Archive I I

Time Period: [ 4 EE]

ID 7 | Inddent Create | User ¥ |Vehide ID T |Incident Name ¥ | Incident Start |Incident End | Duration Extn ¥ | Progress ¥ |Pur 7 | Comple| Type
3/6/2018 10:1C [ Sav-GTD Lab Door (motion)  3/6/2018 9:58: 3/6/2018 9:59 00:00:30
3/6/2018 10:09 [ Sav-GTD Lab Door (motion)  3/6/2018 9:57: 3/6/2018 9:58 00:00:30

3/6/20186 9:58: (5 Sav-GTD Lab Door (motion)  3/6/2018 9:46: 3/6/2018 9:47 00:00:30

3/6/2018 9:52: (@5 5av-GTD Lab Door (motion)  3/6/2018 9:41: 3/6/20189:41 00:00:30
3/6/2018 9:45: @2 5av-GTD Lab Door (motion)  3/6/2018 9:33: 3/6/20189:33 00:00:30
3/6/2018 9:37: [ Sav-GTD Lab Door (motion)  3/6/2018 9:25: 3/6/20189:26 00:00:30

When you select a row, it changes to white, to indicate that it has been reviewed at least once.

Deleting an Incident

If the incident data is no longer required, you can delete incidents from the Archiver. All incidents
are deleted after a certain retention period (default is 120 days) to allow room for new incidents. If
your Archiver is becoming full or you simply want to remove unwanted incident data, you can use
the Incident Archive tab to delete incidents.

Note: You require the Delete/Pause Incidents user right to delete an incident (see “Adding the
Transportation Application Rights to the User Profile” on page 25).

To delete an incident
1 Click the main menu and select Transportation -> Incident Archive.
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The Incident Archive tab opens.

=% Inddent Archive NERE

ID ¥  Inddent Created Usemame ¥ | Vehide ID T | Inddent Name ¥  Incident Start Incident End

Duration Extr T Progress ¥ Purger ¥  Completi| Type ¥ |Path

v

7608  28/02/2023 9:02:28 AM @8 GTDVR  Impact Alarm 28/02/20238: 28/02/2023 8 00:00:30 o 28/02/2( Auto  System/R5 Mobile
7607  28/02/2023 9:00:20 AM @5 GTDVR  Hard brake 28/02/20238: 28/02/20238 00:00:30 28/02/2( Auto  System/R5 Mobile
7606  28/02/2023 8:58:18 AM 5 GTDVR  Tag Alarm 28/02/20238: 28/02/2023 8 00:00:30  f 28/02/2( Auto  System/R5 Mobile
7605  28/02/2023 B:56:15 AM @3 GTDVR  Operator Alarm  28/02/20238: 28/02/20238 00:00:30 28/02/2( Auto  System/R5 Mobile
7604 28/02/2023 8:54:00 AM @5 GTDVR  Hard brake 28/02/2023 8: 28/02/2023 8 00:00:30  f 28/02/2( Auto  System/R5 Mobile
7603  28/02/2023 B:50:30 AM @8 GTDVR  Impact Alarm 28/02/20238: 28/02/2023 8 00:00:30 28/02/2( Auto  System/R5 Mobile

28/02/2023 8:48:29 AM Operator Alarm  28/02/20238: 28/02/2023 8 00:00:30 28/02/2( Auto  System/R5 Mobile

2 Select the incident or incidents you want to delete.

Use the CTRL or SHIFT keys to select multiple incidents from the list.
3 Click the Delete Incident(s) [&] button.

The Delete Incident(s) warning dialog appears.

A\ Delete Inddent(s)

Are you sure you want to delete the selected incident(s)?
Please note that deleting an incident may cause the associated video to
be purged from the Command Media Archiver.

Cancel Apply

4 Click Apply.
A red line appears through the deleted incident.
=% Inddent Archive S are

tov e ] - ¥

1D ¥ | Incident Created | Usemn ¥ | vehicle ID ¥ | Incident Na ¥ | Incident Start | Incident End Duration Extr ¥ |Progress ¥ |Pu T | Completion | Type T | Path
7032 2/26/2018 2:53: TechPub (5 Sav-GTC Techpub test? 2/26/2018 1:52 2/26/2018 2:00 00:08:00 o/ 2/26/2018 7 Scheduled System/R5.

7030  2/26/2018 2:50: TechPub [ Sav-GTC TechPubtest3 2/26/2018 1:49 2/26/2018 1:50 00:10:00 2/26/2018 2 Scheduled  System/RS...

A pop-up notification appears at the bottom of the Incident list, indicating the number of
incidents that have been deleted.

1 incident(s) deleted.

1

Command 2.17 Transportation User Guide 79



Using the Incident Archive

Deleting Selected Video from an Incident

If you have the Media Deletion user right, you can delete recorded video from an incident saved on
the Command Media Archiver (release 2.7 and higher). This allows you to remove selected sections
of video. This is different from deleting the entire incident, as described in “Deleting an Incident” on
page 78. Selective video deletion is useful if you want to delete only video where a particular
person appears (for example, to comply with privacy laws). You keep the incident, but remove
unwanted parts of the video from the incident. You can select the camera and the time period, and
delete only a selected part of the video. When you play back the video afterward, the deleted
section is omitted, and the playback smoothly jumps from the video before the deletion to the
video after the deletion.

Note: If there is recorded audio associated with the video, it is also deleted.

Important: If video is deleted from an incident using this procedure, you cannot retrieve it. Ensure
that you only delete video when necessary. With a video deletion request it is recommended that
you examine the video to search for anything suspicious. If you find something suspicious, contact
your security team or law enforcement. It is recommended that your privacy policy defines how to
address this situation according to the data protection and privacy laws in your country.

Note: When you delete video from an incident, it is deleted from the Command Media Archiver,
not the recorder. If you want to completely delete video from a certain time period, you must also
check the recorder and ensure that the video is deleted from it as well. If you are using shared
cases, ensure that video is deleted from the case files. For more information about deleting
selected video from the recorder and from shared cases, see the Command Enterprise and Client
User Guide.

To manually delete selected video from an incident
1 Open the Incident Archive tab to view the list of incidents.

S Incident Archive X -

ID T | Incdent Created Username T | Viehide ID

¥ Inddent Name ¥ | Inddent Start | Inddent End | Duration |Exir ¥ Progress ¥ |Purger ¥ | Completi Type ¥ | Path

v

7608  28/02/2023 9:02:28 AM (@2 GTDVR Impact Alarm 28/02/20238: 28/04/2023 € 00:00:30 o 28/02/2( Auto System/RS Mobile
7607  28/02/2023 9:00:20 AM @8 GTDVR Hard brake 28/02/20238: 28/02/20238 00:00:30 o 28/02/2( Auto System/RS Mobile
7606  28/02/2023 8:58:18 AM [®= GTDVR  Tag Alarm 28/02/20238: 28/02/2023 8 00:00:30 28/02/2( Auto System/RS Mabile
7605  28/02/2023 8:56:15 AM [®% GTDVR Operator Alarm  28/02/20238: 28/02/2023 € 00:00:30 28/02/2( Auto System/RS Mobile
7604  28/02/2023 8:54:00 AM @8 GTDVR Hard brake 28/02/2023 8: 28/02/20238 00:00:30 o 28/02/2( Auto System/RS Mobile
7603  28/02/2023 8:50:30 AM (= GTDVR Impact Alarm 28/02/20238: 28/02/2023 8 00:00:30 28/02/2( Auto System/RS Mobile

28/02/2023 8:48:29 AM (@8 GTDVR Operator Alarm  28/02/20238: 28/02/2023 € 00:00:30 28/02/21 System/RS Mobile

1 2 3 4 5 6 7 8 9 10 & »

2 Select the incident with the video you want to delete and click the Play Incident button (or
double-click the incident).
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Note: You can only view an incident after it has finished downloading (Progress at 100%).

The incident opens in a new tab. By default, the associated video is paused when you open the
incident and the Delete Video button is unavailable.

S Incident Archive X BE Inddent from Device HA GI® 4+ -

5 11/8/2021

Camera 1 PM _ |Camera 2 11:18:43PM _  IGA
HA_GPS 021 = |HA_GPS "_ = 1B naces

Camera 3 i 11:18:43 PM _  Camera 4

HA GPS 11/8/2021 = HA_GPS
-

g

Monday, November 8

O - LS S = @ 1w [0 3%

Delete Video button (unavailable)

3 The delete video option is only available when the following conditions are met:
* The logged in user has the Media Deletion user right.
For more information on the Media Deletion user right, see the Command Enterprise and
Client User Guide.
* Thevideo in the incident was downloaded from a recorder running software version 5.14 or
higher.
* Thereis a section of video selected on the timeline, and the playback cursor is positioned
within the selection.
4 To make a selection in the current time period, you can place your Playback cursor on the
timeline at the beginning of the time period you are interested in and click the Set Selection

button to set the start and end points for the selection. The Set Selection cursor automatically
sets the start point to 5 seconds before the position of the Playback cursor on the timeline.

You can drag the ends of the selection left or right to refine the time period.

5 Click anywhere within the selected section of video so that the Playback cursor appears in the
selection.
Playback cursor in selected section of video
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After all conditions are met, the Delete Video button becomes available. (You can also
right-click on the timeline and select the Delete Video option that appears in the menu.)

Video selected in timeline

Wednesday, January 21 Wednesday, Jaruary 21 §

-
11:20 AM 11:25 AM | | |
1 0 ' ' 1 -

© M ST B & Bl @ w O %

Delete Video button becomes available

Important: If you do not have the Media Deletion user right, the Delete Video button is not
displayed in the user interface at all.

Recorders running software versions below 5.14 do not support this feature, and the button is
also not displayed.

6 Click the Delete Video 2% button.
The Media Deletion dialog appears.

This dialog shows the camera channel where the selected video comes from, the state, and the
start / end time of the selected video.

£} Media Deletion

Channel Name | Deletion State

4 Camera 1 Ready to delete.

Start: End: Interval:
20/08/2018 [Ef| 10:48:35 AM M 20/08/2018 [F1) 10:49:19 AM - EEIEEEE]

i This operation will delete stored media for all the sectors. oK

7 You can modify the Start and End time of the video for deletion as required, but the current
position of the playback cursor must stay within the video selection. If the playback cursor is
not inside the selection, the Deletion State field displays an error, and the delete operation is
prevented.

The Interval field shows the length of the selected video with the selected start and end times.
8 Click OK.
The Confirm Deletion dialog appears.

i Confirm deletion x

You selected the deletion of recorded media for Camera 1.

This operation cannot be cancelled. Do you want to proceed?

Yes No

9 Click Yes.
The Deletion State field in the Media Deletion dialog shows the progress of the deletion.
10 You can optionally click Close in the Media Deletion dialog before the operation is complete.
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Viewing Available Space on the Archiver

Incidents are saved on the Command Media Archiver. Incidents include video and other data, which
are purged after a set amount of time (default 120 days) to allow room for new incidents. To ensure
that your archiver always has enough space for new incidents, you can monitor the free space on
the archiver by opening it in Command Client to view the exact amount of free space left
remaining. This information tells you when to take action if the archiver is approaching capacity.

To view the available space in an archiver
1 From the Navigation Panel’s System tree, select the Archiver that you want to view.

NAVIGATION EVIDENCE
+ X

- B3 Archivers
Archiver 1

Archiver 2

37

Archiver 3

2 Onthe Navigation toolbar, click the Open in Tab button, or right-click the archiver and select Open.
The archiver tab opens in the workspace.

Name
System/RS5 Mobile/PV_MTO8
System/R5 Mobile/GTDVR
System/R5 Fixed/HT_DVR

Address 10.51.66.47:444

NAT Connection Type  N/A

Registration Address 10.51.66.47

Hostname Archiver 2

Model Command Media Archiver

Serial Number 4ASDF37859D446B7862033AC087061DA 259, /\75%
Station Identifier NVR-10204
Version 2.12.0.3233

: . . Free Space
Registration Status Registered 820.22 GB
. 100%

Service Status In Service

Edit Network Settings

50%

3 At the bottom right of the tab is the free space indicator, which shows both the percentage of
space used and the amount of free space available, measured in GB.

50%

/\;5%

/

os 820.22GB B,

Free Space
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Ensuring the Archiver has Enough Space

It is possible that despite old incidents being purged, your archiver may begin to fill up. It is
important that you monitor the available space on the archiver, and take action if necessary. A
health alert is generated when the archiver reaches 90% capacity, but we recommend that you take
action before the archiver reaches this threshold.

If the archiver is approaching capacity, there are several actions you can take:
* Export important incidents that you want to save to case files

* Delete old or unneeded incidents using the Incident Archiver tab

* Increase the storage capacity of the archiver

* Alter the default incident retention period (default is 120 days)

Exporting Incidents to Case Files

When you export incidents, you save them to other locations, and can then remove them from the
Archiver, freeing up space for new incidents.

For instructions on exporting incidents, see “Exporting an Incident” on page 70.

Deleting Old or Unneeded Incidents

Incidents are automatically deleted after a certain retention period (default is 120 days), but you
can manually delete incidents before the retention period automatically deletes them, if desired.

You must use the Incident Archive tab in Command Client to manually remove old incidents. (Never
delete files associated with the Archiver storage from Windows Explorer or using tools outside
Command Client.)

Note: You require the Delete/Pause Incidents user right to delete incidents.
For instructions on deleting incidents, see “Deleting an Incident” on page 78.

Increasing the Storage Capacity of the Archiver

If you find that your Archiver is constantly filling up too quickly, you can increase the storage
capacity of the drive where the Archiver saves the media files.

The drive where files are stored and the amount of storage designated to the Archiver is configured
when you install the Archiver.

You can modify the Archiver to allocate more space to its storage location.

For instructions on modifying the Archiver, see “Upgrading the Command Media Archiver” on
page 24.

Changing the Default Purge Time Period

The default retention period for files stored by the Archiver is 120 days. After this, incidents are
automatically deleted.

A user with top-level access can change the length of this default time period in the Transportation
Settings (see “Settings for Transportation Configuration” on page 31).
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Exporting Incident Data to a CSV File

You can extract the status data from all the incident extractions in the Incident Archiver page and
export the data to a CSV file.

This can help a system administrator get an overview of the system, for example, an administrator
can view how many incident extractions are currently in progress, to determine if the network has
capacity to perform all of the requests in a reasonable time period.
To export incident data to a CSV file
1 Open the Incident Archive tab to view the list of incidents.

The Export Incident button is at the bottom right of the list of incidents.

% Incdent Archive “|ar|=

QITSEEVNE past 7 Days !

ID T | Incident Created Usemame T | Vehide ID

] B g
¥  Incdent Name T

Incident Start | Incident End | Duration |Exir ¥ Progress T | Purge: ¥ | Completi| Type T | Path

v

7608  28/02/2023 9:02:28 AM @8 GTDVR Impact Alarm 28/02/2023 8: 28/02/20238 00:00:30 o 28/02/21 System/RS Mobile
7607  28/02/2023 9:00:20 AM (= GTDVR Hard brake 28/02/20238: 28/02/2023 8 00:00:30 28/02/2( Auto System/RS Mobile
7606  28/02/2023 8:58:18 AM [@E GTDVR  Tag Alarm 28/02/20238: 28/02/20238 00:00:30 o 28/02/2( Auto System/RS Mobile
7605  28/02/2023 8:56:15 AM = GTDVR Operator Alarm ~ 28/02/20238: 28/02/2023€ 00:00:30 28/02/2( Auto System/RS Mabile
7604  28/02/2023 8:54:00 AM [®= GTDVR Hard brake 28/02/2023 8 2B/0Z/2023 € 00:00:30 28/02/20 Auto System/RS Mobile
7603  28/02/2023 8:50:30 AM @8 GTDVR Impact Alarm 28/02/20238: 28/02/20238 00:00:30 o 28/02/2( Auto System/RS Mobile

28/02/2023 8:48:29 AM Operator Alarm | 28/02/20238: 28/02/2023 & v 28/02/2( System/RS Moljyia

1 2 3 4 5 6 7 8 9 10 »r »

Export Incident button
2 Select the Export Incident button.
A Save As dialog box appears.

3 In the Save As dialog, type a file name and choose a location for the file.
Command saves the file so that it is available for analysis.
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Chapter 4

Using the Incident Search

The Incident Search tab allows you to search the video and data from the RideSafe Series recorders
in all your vehicles to look for specific incidents.

This chapter contains the following topics:

* “Incident Search Scenario” on page 87

* “Setting a Home Location on the Map” on page 87

*  “Searching for Incidents” on page 89

*  “Viewing the Incident Search Results” on page 92

*  “Creating an Incident from the Incident Search Tab” on page 95
*  “Exporting Search Results to a CSV File” on page 97
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Incident Search Scenario

You can use the Incident Search tab to search the RideSafe Series recorders in all your vehicles for
specific incidents. The tab provides search parameters including time period, one or more vehicles,
a user-defined area on the map, a specific event (such as an impact alarm), and the speed of the
vehicle. You can view one or more search results on a map to see exactly where and when the
incidents occurred, then download the relevant video and data.

The following example provides a scenario where you would use this search feature.

Sample Scenario

A customer calls the Transportation agency and reports that a bus driver was using their phone
while driving. The customer reports the bus stop where they exited the bus, which was about 10
minutes after the bus driver was using their phone. The customer is also able to report which
direction the bus was traveling, and the approximate time within 15 minutes.

An investigator uses the map in the Command Incident Search page to draw a geofence around the
bus stop. The investigator draws the area wide enough to include where the bus would have been
10 minutes prior to arriving at the stop. The investigator sets the time period so that it includes 15
minutes before and after the time that the customer indicated the driver was using his phone.

The investigator performs the search and four results are returned. She selects each entry and
determines that only one of the results is near the point of the infraction at the time mentioned. The
investigator requests the video associated with the result.

Setting a Home Location on the Map

You can set a home location on the map so that you can quickly return to the map view where most
of your searches originate, and to the zoom level most convenient to you. The home location is
associated with the user who is currently logged in, so that each user can set their preferred home
location and zoom level.

To set a home location
. . v, . .
1 Click the main menu and select Transportation -> Incident Search.

? Help 3

9 Transportation » =w Incident Archive
— ﬁ‘) Incident Search

] Logout



Using the Incident Search

The Incident Search tab opens.

il 29/01/2017  [E]] 12:00 AM :
To 29/01/2017 B 11:50 PM s

i

Vehide Id

. N <
ﬁa’ %>\ I GT20_Mohile_1
& RN P bil
,_-%‘\\ P GT20_Mobile_2
%
O\ (%« GT20_Maobile_3
% Yo, e

_Ac; < e, Lot GT20_Mobile_4

AN

mee
I Search Above _ mph

RESET = SEARCH

-

Color Vehide Id ¥ | Start Time End Time Max Speed ¥ | Event Count ¥ | Above Speed Count T

2 Set the map view so that it shows the area that you want to designate as your home location
using one or more of the following methods:

* Use the search bar at the top of the map to find a specific area on the map. Type the name
of a location (city, town, street name, other location details).The search bar offers
suggestions as you type and the map moves to a location when you press Enter.

SO Inddent Search NELE

I, @l Ottawa, Ontario, Canadd H

+ Use your mouse pointer to click and drag on the map to move it to a different view.

* Use the Map Zoom button to zoom out to a larger area or zoom in for more detail in a
smaller area. You can also use the mouse scroll wheel to zoom. Scroll up to zoom in and
scroll down to zoom out.

3 When you have set the map to the view (area and zoom level) that you want to designate as
your home location, click the menu H button to the right of the Search bar at the top of the
map.

Click Set as Home Location.

4 The current map view, including the zoom level, is set as your home location. After changing
the map view, click the Home Location n button to return to this view.
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Searching for Incidents

You can use the Incident Search tab to search for specific incidents from RideSafe Series recorders.

Note: A search result must satisfy all search parameters provided, except when your search
includes both Event parameters and Search Above parameters. In this case the search can return
results that include Events OR Search Above instances.

To search for incidents
1 Click the main menu and select Transportation -> Incident Search.

? Help 3

9 Transportation , = Incident Archive
= S Incident Search

ﬂ Log Out

The Incident Search tab opens.

WLl 29/01/2017 )] 12:00 AM :
To 29/01/2017 B 11:50 PM s

% N Z vehide Id )
P, 2, e
i N GT20_Mobile_1
& KN
= 'Fn,a\_ =] P GT20_Mohile_2
{
4
e £ GT20_Mobile 2
S, o

GT20_Mobile_4

mce:
Ry,

RESET = SEARCH

i

SO Search Result: A

Color Vehide Id T | Start Time End Time Max Speed ¥ | Event Count T | Above Speed Count T

2 In the Time Period section, select the period of time during which you want to search for
incidents. Either:

+ Select a pre-configured time frame using the Time Period E button.
+ Customize the dates and times in the From and To boxes to configure your own time period.
Note: The time period must be seven days or less.

3 If you want to filter the search by vehicle, from the Vehicle ID list, select the check box for one
or more vehicles to narrow the search.

Note: If no check boxes are selected, the search automatically includes all available vehicles.

Tip: If there is a long list of vehicles, you can use the Filter il button at the top of the Vehicle ID
list to find the vehicles you are interested in. In the Filter dialog box, select a filter expression
from the list, enter filter criteria in the text box (if applicable), and click Filter.
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After you have filtered the list to the vehicles you are interested in, you can select all the filtered
vehicles by selecting the check box at the top of the list.
Vehide Id
B | vehide 1d
GT20_Mobile_1 Show rows with value that
GT20_Motilz_2 Is equal to

pr———

i Clear Filter

4 Tofilter the search by events, select the Event check box, and select the name of the event you
want to search for from the list.

The events in the list are alarm events specific to your system. Sample events are:

* Impact alarm, triggered when an impact with the vehicle is detected.

* Hard brake, triggered when a level of force greater than normal is applied to the
vehicle’s brakes.

* Panic alarm, manually triggered by the driver when an incident has occurred on the vehicle.

Note: The list of events is populated by the events currently in the database. If events are

added or removed in the database, this list reflects the changes.

5 If you want to filter the search by speed of the vehicle, select the Search Above check box and
enter a speed value in the box provided. The search finds any vehicles traveling above the
speed value you enter. For example, if you enter 50 mph, the search results find any vehicles
traveling faster than that.

Speed appears in mph or km/h, depending on what is set in your Command Preferences (see
“Preferences for Transportation Features” on page 33).

Note: If your search includes both Event parameters and Search Above parameters, the
search can return results that include only Events or only Search Above instances. Selecting
both parameters in a search does not limit the search to results where both are present. The
values in the Event Count and Above Speed Count columns show the details of the results.

6 If you want to isolate a specific area of the map to search, you can use a geofence. The
geofence isolates a portion of the map to search.

To find the location where you want to set the geofence, you can use the search bar at the top
of the map to look for a specific area. Type the name of a location (city, town, street name,
other location details). The search bar offers suggestions as you type and the map moves to a
location when you press Enter. If you have set a home location that you want to search (see
“Setting a Home Location on the Map” on page 87), you can click the Home Location button.

When you have found the location that you want to search, either:

+ Click the Draw Geofence E button.

* Press CTRL and move the mouse over the map.

The cursor changes to a cross to indicate that you can click and drag on the map to create a geofence.

S Incident Search

Geofence cursor

orangewond Averiie |
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A dashed-line box appears on the map: this is the geofence. You can alter the size of the
geofence box by clicking and dragging on any of its four corners. The area contained within the
box is the area that is included in the search. Any area outside the box is not included.

Note: You can remove the geofence by clicking the X at the top right corner of the box.

S9 Inddent Search

| Daniel Avenue

I
Samuel Dri\nl: Samuel Drive
1

I
Eudora Lang

Timmy Lana

a Drive !

aul wsqoy

REENI LT

Cronna Lame
—
100 m

7  Click Search.
The results of the search are displayed in the table below the map.

(¥ Search Result: 23/01/2017 12:00 AM - 29/01/2017 11:59 PM (2)

Color | Wehide Id ¥ | Start Time End Time Max Speed ¥ | Event Count ¥

GT20_Mobile_2 26/01/2017 12:48:24 PM  29/01/2017 11:59:41 PM 66.86 mph 197

Notes:

* The number of search results returned is shown in brackets after the date and time at the
top of the list.

*  The maximum number of results shown in the table is 100.
* You can clear all the search parameters by clicking the Reset button.
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Viewing the Incident Search Results

When you have completed a search, you can use the Search Result table and the map tab to view
details about each result.

Note: You can alphabetically or numerically sort a column list using the Sort [ icon in the column
header (depending on the content of the list). You can filter device data in a column list to show
only specified list values using the Filter |f icon. For more information on sorting and filtering see
the Command Enterprise and Client User Guide.

To view the search results

1 Once you have search results, you can click on one or more rows in the Search Result table and
view the vehicle routes on the map.

Important: If you do not see the route on the map when you click on the search result, click the Zoom
to Fit button on the map. This relocates the map view to show the currently selected result.

Each result is assigned a color. When you select a result in the list, the color shows in the Color
column of the Search Result table, and the route of the vehicle is displayed on a map using the
assigned color.

Notes:

+ Colors are assigned to routes dynamically, so the same search result may appear in
different colors when found using different searches.

* Redisreserved for indicating where a vehicle has exceeded a Search Above search parameter.

= Time Period

il 23/01/2017  [E1) 12:00 AM z
RO 20/01/2017  [E] 11:59 PM z

Vehicle Id

Vehide 1d

+  GT20_Mobile_2
«~  GT20_Mobile_3

Stittsville Event Any
Search Above 65 = M

RESET ~ SEARCH

)’i‘ Search Result: 23/01/2017 12:00 AM - 29/01/2017 11:59 PM b
ot

Color | Vehide Id ¥ | Start Time End Time Max Speed ¥ | Event Count T
GT20_Mobile_2 26/01/2017 12:48:24 PM  29/01/2017 11:59:41 PM 66.86 mph 197

When you move the mouse pointer over the route, an arrow appears to show which direction
the vehicle was traveling, along with the date, time, and speed.

9 Incident Search

16/02/2017 11:43:09 AM
41.63 mph

Orchard Pla;{_.
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2 You can view multiple results in the map simultaneously by pressing the CTRL or SHIFT key and
clicking additional results in the Search Result list. You can select a maximum of five results to
view at one time.

After you have selected the maximum of five results, you must clear at least one selection
before you can select a different result.

Time Period

Rl 20/01/2017 f=1 ) 12:00 AM s
LCRN 30/01/2017  [EIf 11:59 PM s

Vehide Id
GT20_Mobile_1

GT20_Mobile_2
GT20_Mobile 3

Event
= ] Search Above

RESET ~ SEARCH

P Search Result: 30/01/2017 12:00 AM - 30/01/2017 11:59 PM (2) -
Color | vehide 1d Start Tme End Time Max Spe ¥ | Event Count T | Above Speed Count T

B GT20 Mohile 2 30/01/2017 1:03:26 30/01/2017 11:59:32 6531 mph 1

[0 GT20_Mobile 3 30/01/2017 12:00:4 30/01/2017 11:59:28 57.60mph 3

Note: If there is missing GPS information (for example, if the GPS satellite was temporarily
unavailable due to tunnels, weather, or other obstacles), the route is shown as a dashed line
from the point where the GPS information is lost to the point where it becomes available again.

Because the dashed line is merely a visual aid, it does not follow roads. It is a straight line
between available GPS information points, and may travel across terrain that the vehicle clearly
did not, such as over water or through buildings.

)@ Inddent Search

Koreatown —Garden Grove

3 If you filtered the search by Event, the number of events found in each search result are listed
in the Event Count column of the Search Result table.
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Click the Show Event button on the map to display event icons on the vehicle route. You
can move the mouse pointer over the icon to display details of the event. The name of the
event and the date and time that it occurred show in the detail box.

D Inddent Search

pieAa|no|

Impact Alarm
30/01/2017 3:44:

If you filtered the search by Search Above, the number of instances where the speed exceeded
the value entered in the search parameters for each search result is listed in the Above Speed
Count column of the Search Result table.

The portions of the route where the vehicle exceeded the designated speed are shown in red.
When you move the mouse pointer over the red portion of the route, the speed of the vehicle
at that point on the route displays. As you move the mouse along the route, the variations in
the speed show.

Note: The red route color is reserved for indicating that the vehicle has exceeded the
designated speed in the search. Routes where this is not applicable never appear in red.

If you filtered the search using a Geofence, one result is displayed in the list for every incidence
of the vehicle appearing inside the geofence.

For example, if a vehicle enters the geofence at 10:00 and exits at 10:30, then enters again at
14:00 and exits at 14:15, these are shown as two results. For the first result the start time is 10:00
and end time is 10:30, and for the second result the start time is 14:00 and the end time is 14:15.

* If the only portion of the route that is found inside the geofence is a dashed line, indicating
that the GPS information was unavailable, the dashed line is still shown in the results.
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+ For asearch with a geofence, the Start Time is when the vehicle enters the geofence area (or
the earliest time, if the vehicle route starts within the area), and the End Time is when the
vehicle leaves the geofence area (or the latest time, if the vehicle does not leave the area).

* If your search parameters include a geofence and additional parameters, the results
returned must satisfy all parameters (Geofence, Time Period, Vehicle ID), except for the
Event and Search Above parameters, where the result can include one or the other.

Creating an Incident from the Incident Search Tab

You can use the Add Scheduled Extraction dialog to configure the extraction of the video and data
from one of your search results, to create an incident for download. You can view the incident in
the Incident Archive tab.

Note: You can also create an incident from the Incident Archive tab. For more information, see
“Creating an Incident from the Incident Archive Tab” on page 52.
To create an incident from a search result in the Incident Search tab

1 Use the Incident Search tab to find the incident that you want to download video and data
from, as described in “Searching for Incidents” on page 89.

The results of the search are displayed in the table below the map.

)'il Search Result: 23/01/2017 12:00 AM - 29/01/2017 11:59 PM (2)

Color | Vehide Id ¥ | Start Time End Time Max Speed Y | Event Count ¥

GT20_Mobile_2 26/01/2017 12:48:24 PM  29/01/2017 11:59:41 PM 66.86 mph

2 Select the result in the list and click the Create Incident |
The Add Scheduled Incident Extraction dialog appears.

D" Add Scheduled Incident Extraction

Inadent Name:

Camera Name

= Camera 7

T

L

~ W Camerab
«~ ® Camera 8
o

w4 P Camera 2

il 71/01/2015 8:37 AM 3\ 21/01/2015 @) 9:37 AM Interval: 01:00:00

Cancel

3 In the Incident Name box, type a descriptive name for the incident.
4 Select a mobile recorder in the Extract From list box.
This is the recorder installed in the vehicle where the incident occurred.

Note: When you access the dialog from the Incident Search tab, the recorder is already set to
the one from the search result.
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5 Select the check box for one or more cameras in the Camera list.
These are the cameras in the vehicle where the incident occurred.
6 Modify the Start and End date and time, as required.

This is the start and end time of the video and other data you are extracting. When you export
from multiple cameras, all the videos have the same start and end time. The Interval field shows
the length of the video with the selected start and end times.

The maximum duration for a scheduled extraction is 2 hours.

Note: If the selected timeline occurs during the Daylight Saving Time shift, a DST check box is
enabled. When selected, the DST period is included in the extraction.

7 Click Add.
Once created, the incident is added to the list in the Incident Archive tab.
When you open the Incident Archive tab, click the Refresh button to view all the newest

incidents, including the one you just created, or the My Incidents button (see “Viewing My
Incidents” on page 58).

= Incident Archive X 4 -

Time Period: o [EfE | [ e

IDT | Inddent Created T Usemame T| Vehide ID T | Inddent Name ¥ | Inddent Start T | Inddent End T | Duration | Extr. St T | Progress T | Purged 7| Completion Time ¥ | Type ¥|Path

1 7/2/20151:27:00 PM TechPub (B8 GTDVR Sample 1 7/2/2015 1:27:00 PM  7/2/2015 1:29:00 PM  00:02:00 v 7/2/2015 1:27:40 PM  Sched... System/RS DVR

2 7/9/2015 10:46:00 AM TechPub (®5 GTDVR Sample 2 7/9/2015 10:46:00 AM  7/9/2015 10:50:00 AM  00:04:00 v 7/9/2015 10:46:45 AM Sched... System/R5 DVR
(e

Note: If the incident fails to download, you can use the Retry Incident button to restart
the download and try again.

Use the functionality available from the Incident Archive tab to view the incident and export the
video and data. See “Using the Incident Archive” on page 51 for more information.

8 Depending on factors such as the length of the video you are extracting, the availability of the
recorder you are extracting from (CES may have to wait for a bus to return to the Depot to
contact the mobile recorder), the incident extraction may take some time.

The Extraction Status column displays icons that help you track the progress of your incident
download. These icons and their meanings are listed in the “Incident Archive Tab User
Interface” on page 39 (see the table).

You can hover your mouse over the icon to see additional information about the status.

When your incident extraction is successfully completed, the Extraction Status column displays the
Success icon v indicating that the Incident is successfully created and saved in the Archiver.

Incident End Duration | Extraction Status ¥ | Progress ¥  Purged T
03/05/2019 2:09:10 PM  00:00:30 Jl}
|

| Download successfu

Note: If your incident fails to download and shows the red Alert icon, you can hover your
mouse over the icon to see additional information about why the download failed. See
“Troubleshooting an Incident Extraction” on page 54 for more details.
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Exporting Search Results to a CSV File

You can export the information from the Search Results to a CSV (Comma Separated Values) file.

All the results that appear in the Search Results list are exported to the file.

To export search results to a CSV file
1 Use the Incident Search tab to find the incident that you want to download video and data
from, as described in “Searching for Incidents” on page 89.

The results of the search are displayed in the table below the map.

)'il Search Result: 23/01/2017 12:00 AM - 29/01/2017 11:59 PM (2)

Color | Vehide Id ¥ | Start Time End Time Max Speed Y | Event Count ¥
GT20_Mobile_2 26/01/2017 12:48:24 PM  29/01/2017 11:59:41 PM  66.86 mph 197

2 Click the Export to CSV E;i button (above the list of results).

A Save As dialog box appears.
3 Inthe Save As dialog, type a file name and choose a location for the file.

Command saves the file so that it is available for analysis.
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Chapter 5

Using the Command Player with
Transportation

Command Player is a standalone software tool that allows you to view (and authenticate) video
files exported from Command in the proprietary CME (Command Multimedia Evidence) file format.
This proprietary file format ensures that sensitive video evidence cannot be easily shared over the
Internet.

To learn how to use the Command Player’s basic functionality, see the Command Player User Guide,
available from the March Networks Partner Portal website, or from the Help menu item in Command
Player.

This chapter describes how to use the transportation features of the Command Player.
It contains the following topics:

*  “GPS Controls in the Command Player” on page 99

*  “Viewing a Video File with GPS Data in Command Player” on page 100

Command 2.17 Transportation User Guide 98



Using the Command Player with Transportation

GPS Controls in the Command Player

In addition to the basic controls described in the Command Player User Guide (available from the
March Networks Partner Portal website, or from the Help menu item in Command Player), the
Player has tools available for when the video file has GPS map data.

Show/Hide GPS Map Panel button

Vit Length
00:10:00

GPS Map configuration buttons

E

Fadden Pae —

South Main St
Grand Avis
&
4
o ,1%

< S Vehicle route (blue line)

Bristol St

1
?}
I
|
;&

|_— Vehicle location

Date/time, vehicle speed, and GPS coordinates
The GPS map configuration buttons are exactly the same as the buttons that appear in the
Command Enterprise Client application, as described in “GPS Map User Interface” on page 46.

If the video was exported with both default and custom maps, an additional button appears that
allows you to toggle between the default GPS map and the custom map.

Wideo Length
00:05:00 0

Use Default or Custom Map button
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Viewing a Video File with GPS Data in Command Player

You can view a video evidence file with GPS data in the Command Player using the portable version
or the installed version of Command Player.

The Command Player displays the GPS map in the display area with the video, and provides tools
to investigate the GPS data.

To view evidence files with GPS information in the Command Player
1 Open the CME video file with GPS data in the Command Player.

Note: If the video file is encrypted, a dialog appears and you must enter the password for the
file before you can view the video.

If it is a single video file, it automatically opens in the display area, with the GPS map panel
displayed. The video opens in playback mode. The GPS map shows the progress of the vehicle
along the route as the video shows the view from the camera.

Y &5

RESOURCES

1:47 M
i ' i 1 0 i
1:46:48 P Tuesday, February 2

B« <« 1 » »» [T

If it is a case file, it opens in the Resources section, and you must select the video file to open it
in the display area with the GPS map.

RESOURCES

gl Note

Camera 1
9/25/2021 10:05:34 AM - 5/23/2021)

PTZ Camera
9/25/2021 10:37:00 AM - 5/23/2021]

Camera 1 snapshot
M 5/25/2021 11:35:30 AM - 5/29/2021

« PTZ Camera snapshot
9/29/2021 11:37:47 AM - 5/25/2021]

o mm View-20210220.122135-20210)
"®  (20/02/2021 12:21:35 PM - 20/02/2{

» (M) PTZ Minidome motion

4
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If you select a view, multiple video streams open with the GPS map panel displayed. The videos
play automatically, in synchronized mode. The GPS map shows the progress of the vehicle
along the route as the videos show the views from the cameras.

V’ Mai
. COMMAND
RESOURCES 7 | BB View-20210310.150642-20210310.150742

il note

E 1P Camerz 1
04/02/2021 9:22:22 AM - 04/02/2021 9:23:

1P Camerz 1-HAGPS-20210204.11072(
04/02/2021 11:07:28 AM

v 2R View-20210310.150642-20210310.15

E Camera 8
10/03/2021 3:12:07 PM - 10/03/2021 3

E 1P Camerz 1
10/03/2021 3:12:07 PM - 10/03/2021 3

E 1P Camera 2 ;
10/03/2021 3:12:07 PM - 10/03/2021 3 {8

E 1P Camerz 3
10/03/2021 3:12:07 PM -

10/03/2021 3§

Camera 3

:53 PM
NE, 42.921958 N, 78.842857 V|18 km,
312:07 PM  Wednesday, March 10 10/03/2021 3:12:53 PM ‘Wednesday, March 10 3:14:07 PM

M 44 I > [T Fl & O 4%

2 You can click Pause n to stop the video and the progress of the vehicle on the GPS map at
any point. You can click on the timeline to move the video and GPS map to a new point in time.
You can use the other Command Player buttons as you would with any non-GPS video in the
Player (for more information, see the Command Player User Guide, available from the March
Networks Partner Portal website, or from the Help menu item in Command Player).

3 You can click on the route in the GPS map to move the vehicle information to a new location.

Note: It is possible that not all points in the route have available GPS data - for example, if the
vehicle goes into a tunnel where satellite information is unavailable, that part of the route does
not have GPS data.

4 You can click the Show Video Information m button to show the name of the recorder, the
name of the camera, the time, the speed of the vehicle, and the GPS coordinates on each
video.

DVR5
Camera 12 - 3:12:53 PM
18 km/h, 72° NE, 42.921958 N, 78.842857 W

5 You can click the Show/Hide GPS Map Panel @ button to show and hide the map panel.
When the map panel is hidden, only the video panel shows (if the Show Video Information
button is selected, the video panel still shows the GPS coordinates on the video).

Command 2.17 Transportation User Guide 101



Command Client

A software interface that allows users to review and export recorded video evidence, and to view
video from cameras connected to recording devices. The Command Client is the source of the
evidence files you view in Command Player (videos, images, and notes).

You can connect the Command Client interface to a Command Enterprise Server, which allows you
to manage multiple recorders and access all the Command Transportation features.

You can alternatively connect the Command Client interface to a single recorder, and manage that
single recorder only. Not all Command Transportation features are available when connected to a
single recorder.

Command Media Archiver

The Command Media Archiver is software that collects and stores video and other data from
recording devices. For example, the Archiver can be used to collect incident video from mobile
recorders located in vehicles. The collected information is then available for the Command Solution
to process.

Dewarping

Certain panoramic PTZ cameras with special lenses support 360° views. When you view the video
or images from these cameras, they have a distorted appearance (often referred to as a fisheye
view). To view the images without this distortion, you must use lens dewarping.

The dewarping options offered by Command Player include Virtual PTZ, Perimeter View, and Split
Perimeter View.

Mobile Recorders

Also referred to as “transit” recorders. Recorders used in the transportation industry, that are
installed in a moving vehicle, such as a bus. The term “mobile” (or “transit”) differentiates from
“fixed” recorders, that are installed in a stationary environment such as a building.



Perimeter View and Split Perimeter View

Perimeter View is a dewarping feature that turns the original fisheye view into a single 360° view
for a ground or ceiling mounted camera or into a single 180° view for a wall mounted camera.

The Perimeter Split View is a dewarping feature that turns the original fisheye view into two 180°
views (the 360° view divided into two views) for a ground or ceiling mounted camera. This option
is not available for a wall mounted camera.

Playback Cursor

A graphical tool on the video evidence timeline. You can move this tool back and forth on the
timeline to quickly view different points in the video.

Resources Area

Located on the left of the Command Player interface, under the main menu button, the resources
area lists the available evidence for you to view: the video, image, and note files.

Text Overlay
Text that has been superimposed over an image file or a video file.

Timeline

A visual representation of the time in a video evidence file. The timeline shows the date and time of
a video from the beginning of the recording to the end. It includes a playback cursor, which you can
move along the timeline to view different points in the video.

View
A grid with multiple video files displayed at the same time.

Virtual PTZ

Virtual Pan, Tilt, Zoom. A PTZ camera is a closed-circuit television camera with remote directional
and zoom control. Virtual PTZ is a dewarping feature that emulates a PTZ camera view, and allows
you to navigate in the image using the digital zoom controls.

Zoom

The zoom feature allows you to move to a close-up shot of an object in the video or image file, to
move the view of the zoomed area, and to move back out of the close-up.



Company Overview

March Networks® helps organizations transform video into business intelligence through
the integration of surveillance video, analytics, and data from business systems and loT
devices. Companies worldwide use our software solutions to improve efficiency and
compliance, reduce losses and risk, enhance customer service and compete more
successfully. With deep roots in video security and networking, March Networks is also
recognized as the leader in scalable, enterprise-class video management and hosted
services. We are proud to work with many of the world’s largest financial institutions,
retail brands, cannabis operators and transit authorities, and deliver our software and
systems through an extensive distribution and partner network in more than 70 countries.
Founded in 2000, March Networks is headquartered in Ottawa, Ontario, Canada. For
more information, please visit

Customer Support and Assistance

Certified partners can telephone our Technical Support team Monday to Friday during
business hours or email at any time.

North America, South America, & Asia Pacific

Telephone - 1 613 591 1441
Toll Free (US & Canada) - 1 800 472 0116
Email - techsupport@marchnetworks.com

Europe, Middle East, & Africa

Telephone - +39 0362 17935 extension 3
Email - supporteurope@marchnetworks.com

If you have purchased a March Networks solution through one of our Certified Partners, please
contact your representative directly for first level technical support and assistance with RMA
services.
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